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Safety notices

Safety notices may be printed throughout this guide:
v DANGER notices call attention to a situation that is potentially lethal or extremely hazardous to

people.
v CAUTION notices call attention to a situation that is potentially hazardous to people because of some

existing condition.
v Attention notices call attention to the possibility of damage to a program, device, system, or data.

World Trade safety information

Several countries require the safety information contained in product publications to be presented in their
national languages. If this requirement applies to your country, safety information documentation is
included in the publications package (such as in printed documentation, on DVD, or as part of the
product) shipped with the product. The documentation contains the safety information in your national
language with references to the U.S. English source. Before using a U.S. English publication to install,
operate, or service this product, you must first become familiar with the related safety information
documentation. You should also refer to the safety information documentation any time you do not
clearly understand any safety information in the U.S. English publications.

Replacement or additional copies of safety information documentation can be obtained by calling the IBM
Hotline at 1-800-300-8751.

German safety information

Das Produkt ist nicht für den Einsatz an Bildschirmarbeitsplätzen im Sinne § 2 der
Bildschirmarbeitsverordnung geeignet.

Laser safety information

IBM® servers can use I/O cards or features that are fiber-optic based and that utilize lasers or LEDs.

Laser compliance

IBM servers may be installed inside or outside of an IT equipment rack.

DANGER: When working on or around the system, observe the following precautions:

Electrical voltage and current from power, telephone, and communication cables are hazardous. To avoid
a shock hazard:
v If IBM supplied the power cord(s), connect power to this unit only with the IBM provided power cord.

Do not use the IBM provided power cord for any other product.
v Do not open or service any power supply assembly.
v Do not connect or disconnect any cables or perform installation, maintenance, or reconfiguration of this

product during an electrical storm.
v The product might be equipped with multiple power cords. To remove all hazardous voltages,

disconnect all power cords.
– For AC power, disconnect all power cords from their AC power source.
– For racks with a DC power distribution panel (PDP), disconnect the customer’s DC power source to

the PDP.
v When connecting power to the product ensure all power cables are properly connected.
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– For racks with AC power, connect all power cords to a properly wired and grounded electrical
outlet. Ensure that the outlet supplies proper voltage and phase rotation according to the system
rating plate.

– For racks with a DC power distribution panel (PDP), connect the customer’s DC power source to
the PDP. Ensure that the proper polarity is used when attaching the DC power and DC power
return wiring.

v Connect any equipment that will be attached to this product to properly wired outlets.
v When possible, use one hand only to connect or disconnect signal cables.
v Never turn on any equipment when there is evidence of fire, water, or structural damage.
v Do not attempt to switch on power to the machine until all possible unsafe conditions are corrected.
v Assume that an electrical safety hazard is present. Perform all continuity, grounding, and power checks

specified during the subsystem installation procedures to ensure that the machine meets safety
requirements.

v Do not continue with the inspection if any unsafe conditions are present.
v Before you open the device covers, unless instructed otherwise in the installation and configuration

procedures: Disconnect the attached AC power cords, turn off the applicable circuit breakers located in
the rack power distribution panel (PDP), and disconnect any telecommunications systems, networks,
and modems.

DANGER:
v Connect and disconnect cables as described in the following procedures when installing, moving, or

opening covers on this product or attached devices.
To Disconnect:
1. Turn off everything (unless instructed otherwise).
2. For AC power, remove the power cords from the outlets.
3. For racks with a DC power distribution panel (PDP), turn off the circuit breakers located in the

PDP and remove the power from the Customer's DC power source.
4. Remove the signal cables from the connectors.
5. Remove all cables from the devices.

To Connect:
1. Turn off everything (unless instructed otherwise).
2. Attach all cables to the devices.
3. Attach the signal cables to the connectors.
4. For AC power, attach the power cords to the outlets.
5. For racks with a DC power distribution panel (PDP), restore the power from the Customer's DC

power source and turn on the circuit breakers located in the PDP.
6. Turn on the devices.

Sharp edges, corners and joints may be present in and around the system. Use care when handling
equipment to avoid cuts, scrapes and pinching. (D005)

(R001 part 1 of 2):

DANGER: Observe the following precautions when working on or around your IT rack system:
v Heavy equipment–personal injury or equipment damage might result if mishandled.
v Always lower the leveling pads on the rack cabinet.
v Always install stabilizer brackets on the rack cabinet.
v To avoid hazardous conditions due to uneven mechanical loading, always install the heaviest devices

in the bottom of the rack cabinet. Always install servers and optional devices starting from the bottom
of the rack cabinet.

v Rack-mounted devices are not to be used as shelves or work spaces. Do not place objects on top of
rack-mounted devices. In addition, do not lean on rack mounted devices and do not use them to
stabilize your body position (for example, when working from a ladder).
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v Each rack cabinet might have more than one power cord.
– For AC powered racks, be sure to disconnect all power cords in the rack cabinet when directed to

disconnect power during servicing.
– For racks with a DC power distribution panel (PDP), turn off the circuit breaker that controls the

power to the system unit(s), or disconnect the customer’s DC power source, when directed to
disconnect power during servicing.

v Connect all devices installed in a rack cabinet to power devices installed in the same rack cabinet. Do
not plug a power cord from a device installed in one rack cabinet into a power device installed in a
different rack cabinet.

v An electrical outlet that is not correctly wired could place hazardous voltage on the metal parts of the
system or the devices that attach to the system. It is the responsibility of the customer to ensure that
the outlet is correctly wired and grounded to prevent an electrical shock.

(R001 part 2 of 2):

CAUTION:

v Do not install a unit in a rack where the internal rack ambient temperatures will exceed the
manufacturer's recommended ambient temperature for all your rack-mounted devices.

v Do not install a unit in a rack where the air flow is compromised. Ensure that air flow is not blocked
or reduced on any side, front, or back of a unit used for air flow through the unit.

v Consideration should be given to the connection of the equipment to the supply circuit so that
overloading of the circuits does not compromise the supply wiring or overcurrent protection. To
provide the correct power connection to a rack, refer to the rating labels located on the equipment in
the rack to determine the total power requirement of the supply circuit.

v (For sliding drawers.) Do not pull out or install any drawer or feature if the rack stabilizer brackets are
not attached to the rack. Do not pull out more than one drawer at a time. The rack might become
unstable if you pull out more than one drawer at a time.

v (For fixed drawers.) This drawer is a fixed drawer and must not be moved for servicing unless specified
by the manufacturer. Attempting to move the drawer partially or completely out of the rack might
cause the rack to become unstable or cause the drawer to fall out of the rack.
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CAUTION:
Removing components from the upper positions in the rack cabinet improves rack stability during
relocation. Follow these general guidelines whenever you relocate a populated rack cabinet within a
room or building.

v Reduce the weight of the rack cabinet by removing equipment starting at the top of the rack
cabinet. When possible, restore the rack cabinet to the configuration of the rack cabinet as you
received it. If this configuration is not known, you must observe the following precautions:

– Remove all devices in the 32U position (compliance ID RACK-001 or 22U (compliance ID RR001)
and above.

– Ensure that the heaviest devices are installed in the bottom of the rack cabinet.

– Ensure that there are little-to-no empty U-levels between devices installed in the rack cabinet
below the 32U (compliance ID RACK-001 or 22U (compliance ID RR001) level, unless the
received configuration specifically allowed it.

v If the rack cabinet you are relocating is part of a suite of rack cabinets, detach the rack cabinet from
the suite.

v If the rack cabinet you are relocating was supplied with removable outriggers they must be
reinstalled before the cabinet is relocated.

v Inspect the route that you plan to take to eliminate potential hazards.

v Verify that the route that you choose can support the weight of the loaded rack cabinet. Refer to the
documentation that comes with your rack cabinet for the weight of a loaded rack cabinet.

v Verify that all door openings are at least 760 x 230 mm (30 x 80 in.).

v Ensure that all devices, shelves, drawers, doors, and cables are secure.

v Ensure that the four leveling pads are raised to their highest position.

v Ensure that there is no stabilizer bracket installed on the rack cabinet during movement.

v Do not use a ramp inclined at more than 10 degrees.

v When the rack cabinet is in the new location, complete the following steps:

– Lower the four leveling pads.

– Install stabilizer brackets on the rack cabinet.

– If you removed any devices from the rack cabinet, repopulate the rack cabinet from the lowest
position to the highest position.

v If a long-distance relocation is required, restore the rack cabinet to the configuration of the rack
cabinet as you received it. Pack the rack cabinet in the original packaging material, or equivalent.
Also lower the leveling pads to raise the casters off of the pallet and bolt the rack cabinet to the
pallet.

(R002)

(L001)

DANGER: Hazardous voltage, current, or energy levels are present inside any component that has this
label attached. Do not open any cover or barrier that contains this label. (L001)

(L002)
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DANGER: Rack-mounted devices are not to be used as shelves or work spaces. (L002)

(L003)

1 2
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3 4
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Safety notices ix



1
2

3
4

or

DANGER: Multiple power cords. The product might be equipped with multiple AC power cords or
multiple DC power cables. To remove all hazardous voltages, disconnect all power cords and power
cables. (L003)

(L007)

CAUTION: A hot surface nearby. (L007)

(L008)
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CAUTION: Hazardous moving parts nearby. (L008)

All lasers are certified in the U.S. to conform to the requirements of DHHS 21 CFR Subchapter J for class
1 laser products. Outside the U.S., they are certified to be in compliance with IEC 60825 as a class 1 laser
product. Consult the label on each part for laser certification numbers and approval information.

CAUTION:
This product might contain one or more of the following devices: CD-ROM drive, DVD-ROM drive,
DVD-RAM drive, or laser module, which are Class 1 laser products. Note the following information:

v Do not remove the covers. Removing the covers of the laser product could result in exposure to
hazardous laser radiation. There are no serviceable parts inside the device.

v Use of the controls or adjustments or performance of procedures other than those specified herein
might result in hazardous radiation exposure.

(C026)

CAUTION:
Data processing environments can contain equipment transmitting on system links with laser modules
that operate at greater than Class 1 power levels. For this reason, never look into the end of an optical
fiber cable or open receptacle. Although shining light into one end and looking into the other end of
a disconnected optical fiber to verify the continuity of optic fibers many not injure the eye, this
procedure is potentially dangerous. Therefore, verifying the continuity of optical fibers by shining
light into one end and looking at the other end is not recommended. To verify continuity of a fiber
optic cable, use an optical light source and power meter. (C027)

CAUTION:
This product contains a Class 1M laser. Do not view directly with optical instruments. (C028)

CAUTION:
Some laser products contain an embedded Class 3A or Class 3B laser diode. Note the following
information: laser radiation when open. Do not stare into the beam, do not view directly with optical
instruments, and avoid direct exposure to the beam. (C030)

CAUTION:
The battery contains lithium. To avoid possible explosion, do not burn or charge the battery.

Do Not:
v ___ Throw or immerse into water
v ___ Heat to more than 100°C (212°F)
v ___ Repair or disassemble

Exchange only with the IBM-approved part. Recycle or discard the battery as instructed by local
regulations. In the United States, IBM has a process for the collection of this battery. For information,
call 1-800-426-4333. Have the IBM part number for the battery unit available when you call. (C003)
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CAUTION:
Regarding IBM provided VENDOR LIFT TOOL:
v Operation of LIFT TOOL by authorized personnel only.
v LIFT TOOL intended for use to assist, lift, install, remove units (load) up into rack elevations. It is

not to be used loaded transporting over major ramps nor as a replacement for such designated tools
like pallet jacks, walkies, fork trucks and such related relocation practices. When this is not
practicable, specially trained persons or services must be used (for instance, riggers or movers).

v Read and completely understand the contents of LIFT TOOL operator's manual before using.
Failure to read, understand, obey safety rules, and follow instructions may result in property
damage and/or personal injury. If there are questions, contact the vendor's service and support.
Local paper manual must remain with machine in provided storage sleeve area. Latest revision
manual available on vendor's web site.

v Test verify stabilizer brake function before each use. Do not over-force moving or rolling the LIFT
TOOL with stabilizer brake engaged.

v Do not move LIFT TOOL while platform is raised, except for minor positioning.
v Do not exceed rated load capacity. See LOAD CAPACITY CHART regarding maximum loads at

center versus edge of extended platform.
v Only raise load if properly centered on platform. Do not place more than 200 lb (91 kg) on edge of

sliding platform shelf also considering the load's center of mass/gravity (CoG).
v Do not corner load the platform tilt riser accessory option. Secure platform riser tilt option to main

shelf in all four (4x) locations with provided hardware only, prior to use. Load objects are designed
to slide on/off smooth platforms without appreciable force, so take care not to push or lean. Keep
riser tilt option flat at all times except for final minor adjustment when needed.

v Do not stand under overhanging load.
v Do not use on uneven surface, incline or decline (major ramps).
v Do not stack loads.
v Do not operate while under the influence of drugs or alcohol.
v Do not support ladder against LIFT TOOL.
v Tipping hazard. Do not push or lean against load with raised platform.
v Do not use as a personnel lifting platform or step. No riders.
v Do not stand on any part of lift. Not a step.
v Do not climb on mast.
v Do not operate a damaged or malfunctioning LIFT TOOL machine.
v Crush and pinch point hazard below platform. Only lower load in areas clear of personnel and

obstructions. Keep hands and feet clear during operation.
v No Forks. Never lift or move bare LIFT TOOL MACHINE with pallet truck, jack or fork lift.
v Mast extends higher than platform. Be aware of ceiling height, cable trays, sprinklers, lights, and

other overhead objects.
v Do not leave LIFT TOOL machine unattended with an elevated load.
v Watch and keep hands, fingers, and clothing clear when equipment is in motion.
v Turn Winch with hand power only. If winch handle cannot be cranked easily with one hand, it is

probably over-loaded. Do not continue to turn winch past top or bottom of platform travel.
Excessive unwinding will detach handle and damage cable. Always hold handle when lowering,
unwinding. Always assure self that winch is holding load before releasing winch handle.

v A winch accident could cause serious injury. Not for moving humans. Make certain clicking sound
is heard as the equipment is being raised. Be sure winch is locked in position before releasing
handle. Read instruction page before operating this winch. Never allow winch to unwind freely.
Freewheeling will cause uneven cable wrapping around winch drum, damage cable, and may cause
serious injury. (C048)

Power and cabling information for NEBS (Network Equipment-Building System)
GR-1089-CORE

The following comments apply to the IBM servers that have been designated as conforming to NEBS
(Network Equipment-Building System) GR-1089-CORE:
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The equipment is suitable for installation in the following:
v Network telecommunications facilities
v Locations where the NEC (National Electrical Code) applies

The intrabuilding ports of this equipment are suitable for connection to intrabuilding or unexposed
wiring or cabling only. The intrabuilding ports of this equipment must not be metallically connected to the
interfaces that connect to the OSP (outside plant) or its wiring. These interfaces are designed for use as
intrabuilding interfaces only (Type 2 or Type 4 ports as described in GR-1089-CORE) and require isolation
from the exposed OSP cabling. The addition of primary protectors is not sufficient protection to connect
these interfaces metallically to OSP wiring.

Note: All Ethernet cables must be shielded and grounded at both ends.

The ac-powered system does not require the use of an external surge protection device (SPD).

The dc-powered system employs an isolated DC return (DC-I) design. The DC battery return terminal
shall not be connected to the chassis or frame ground.

The dc-powered system is intended to be installed in a common bonding network (CBN) as described in
GR-1089-CORE.
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Hardware Management Console service (Machine Type 7042)

Use this information for troubleshooting, service, and support of your machine type 7042 Hardware
Management Console (HMC).

The HMC connects to one or more managed systems to perform various functions. The HMC's primary
functions include:
v Providing a console for system administrators and service providers to manage server hardware.
v Creating and maintaining a multiple partitioned environment on a managed system.
v Detecting, reporting, and storing changes in hardware conditions.
v Acting as a service focal point for service providers to determine an appropriate service strategy.
v Displaying operating system session terminals for each partition.

The HMC is delivered with its machine code preinstalled on the disk drive. After the system is installed
and connected to a managed system, you can perform system management tasks.

The HMC machine code does not have provisions for loading or running additional applications that are
not related to hardware management or service. All the tasks you need to maintain the managed system,
the underlying operating system, and the HMC machine code are available by using the HMC
management interface.

Identifying your HMC
This information supports HMC machine types 7042-CR7, 7042-CR8, and 7042-CR9.

The following illustrations identify each of the machine type 7042 models and show the cable connections
located on the back of each HMC model.
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Figure 1. Model 7042-C08 (Front view)

Figure 2. Model 7042-CR5 (Front view)
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Figure 3. Model 7042-CR6 (Front view)

Figure 4. Model 7042-CR7 or 7042-CR8 (Front view of the server model with a 2.5-inch hard disk drive)

Figure 5. Model 7042-CR7 or 7042-CR8 (Front view of the server model with a 3.5-inch hard disk drive)
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Figure 6. Model 7042-CR7 or 7042-CR8 (Rear view)

Figure 7. Model 7042-CR9 (Front view of the server model with 2.5-inch hard disk drives)

Figure 8. Model 7042-CR9 (Rear view)
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Managed system operation

The HMC graphical interface provides the functions needed to create and maintain a partitioned
environment on a managed system. Using the interface allows for direct manipulation of HMC-defined
objects and increased information regarding detected changes in hardware conditions.

The managed system can be run as a partitioned system, sometimes referred to as logically partitioned.
This means that the managed system can run multiple operating systems simultaneously. The system can
also run as a large single partition, which is known as the manufacturing default configuration when the
system is delivered. If the system has been partitioned, then the single partition that uses all the system
resources is referred to as a full system partition.

Partitioning provides users with the ability to divide a single managed system into several systems. Each
of these systems, running in a partition, can run applications in multiple, independent environments
simultaneously. Logical partitioning makes it possible for a user to run a single application using different
sets of data on separate partitions, as if that application were running independently on separate physical
systems. By creating partitions, for example, a company can test its programs in one partition while
developing the same program in another, at the same time, all using the same system. This same system
partitioning method is more cost-effective, potentially eliminating the need for a separate test system.

The full system partition is no different from the traditional way of using a system. The single server uses
all of its resources as one system.

HMC system diagnostics
Your HMC system also provides a set of diagnostic procedures to be used when troubleshooting HMC
problems. For details on accessing the HMC diagnostics, see “HMC diagnostics” on page 8.

Power on the HMC
For HMC power-on procedures, see “Power on the HMC” on page 47.

Power off the HMC
For HMC power-off procedures, see “Power off the HMC” on page 47.

Power-on self-test
To perform power-on self-test procedures, see “Power-on self-test” on page 47.

Specifications and system unit locations

Your HMC system is based on a model of server. For information about system specifications and system
unit locations, use the appropriate server hardware maintenance manuals. See “Equivalent maintenance
information for the HMC server hardware” on page 9.

Cable the HMC
For HMC power off procedures, see “Cabling the HMC” on page 33.

External ac power cable for the HMC

To avoid electrical shock, a power cable with a grounded attachment plug is provided. Use only properly
grounded outlets.
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Power cables used in the United States and Canada are listed by Underwriter's Laboratories (UL) and
certified by the Canadian Standards Association (CSA). These power cords consist of the following parts:
v Electrical cables, type ST
v Attachment plugs complying with National Electrical Manufacturers Association (NEMA) L6-30P
v Appliance couplers complying with International Electrotechnical Commission (IEC) Standard 320,

Sheet C13 and C14

Power cables used in other countries consist of the following parts:
v Electrical cables, type HD21 or HD22
v Attachment plugs approved by the appropriate testing organization for the specific countries where

they are used
v Appliance couplers complying with the International Electrotechnical Commission (IEC) Standard 320,

Sheet C13 and C14

For a listing of power cables used by the HMC, see “Power cords” on page 31.

For a more complete listing of power cords, see Planning for power.

Removal and replacement procedures
Select and then perform the part removal and replacement procedures for the personal computer on
which your Hardware Management Console (HMC) is based.

Depending on the system configuration, when you are directed to exchange parts, run tests, or change
configuration data, the interface to the managed systems will be unavailable. If possible, before starting
any of these tasks, ensure that all system management tasks are completed and all critical data is backed
up.

Attention:

v Removing power from an HMC might cause loss of data on the disk drives. If power must be
removed, select Power Off from the HMC user interface. This action shuts down the operating system
and turns off the power to the HMC. See “HMC and system power-on and power-off procedures” on
page 47 before proceeding with any of the removal procedures.

v The system board, adapters, memory modules, and processor modules can be damaged by electrostatic
discharge. If you are directed to exchange FRUs in an HMC, see the information about handling
electro-static discharge (ESD) sensitive devices in the appropriate PC maintenance information
manuals.

When you are referred to the hardware maintenance manual for the personal computer, use the hardware
maintenance manual for the appropriate personal computer machine type. To find documentation about
the base HMC personal computer and its components, see “Equivalent maintenance information for the
HMC server hardware.”

Equivalent maintenance information for the HMC server hardware

Use the information provided to help cross-reference your HMC equivalent machine type and model
number for the base server. You can use the entries in this table to link directly to the base server
maintenance documentation.

6 Hardware Management Console service (Machine Type 7042)
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Table 1. Equivalent maintenance information for server hardware used for each HMC model

HMC machine type and model
number (available on the serial
number plate of your HMC)

Equivalent server machine type and
model number

Hardware maintenance manuals
(HMM)

7042-C08 7946 Model 52U See Problem determination and
service guide

7042-CR5 7946 Model 52U or 7946 Model PAL See Problem determination and
service guide

7042-CR6 7944 Model PCH See Problem determination and
service guide

7042-CR7 and 7042-CR8 7914 Model PCH See Problem determination and
service guide

7042-CR9 5463 Model AC1 See Problem determination and
service guide

For the latest information regarding maintenance of your HMC server, system board specifications, and
parts, see server hardware maintenance manuals. To obtain the latest versions of these publications,
complete the following steps:
1. Go to the IBM Support Portal.
2. In the Product finder field, type the equivalent server machine type and model number that

corresponds to your HMC machine type and model number. Then, press enter.
3. Select the product that matches your equivalent server machine type and model. Click Operating

system independent. Then, click Go.
4. In the product support content area, click Troubleshooting documentation.
5. Select the problem determination and service guide.

Recovering the HMC

If the HMC has had a problem and you need to recover the HMC, see “Reinstalling the HMC machine
code” on page 49.

Attention: This procedure will restore the HMC image onto the disk drive in the HMC personal
computer. Before performing this procedure, contact HMC support and also ensure that there are backups
for all critical console data.

Backing up partition profiles

Ensure that critical data that is stored on the HMC is also regularly maintained on backup media.

To back up partition profiles, see “Backing up partition profiles” on page 49.

HMC machine code updates

For information about updates or upgrades for the HMC machine code, see “Upgrading the machine
code on an HMC” on page 53.

Recovering an HMC after replacing a disk drive

If you have to replace a disk drive, you must recover the HMC image and restore your stored profile
data. For more information, see “Reinstalling the HMC machine code” on page 49.
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Rebuilding a Redundant Array of Independent Disks (RAID) 1 array

For information about how to rebuild a RAID 1 array on your HMC that has a failed disk drive or
solid-state drive, see Rebuilding a RAID 1 array.

Performing the firmware (BIOS/VPD) update procedure (after replacing the system
board)

When your replace the system board, perform the firmware update procedure for your HMC personal
computer.

Attention: Refer to the information label located inside the system unit cover for any model-specific
information.

To perform the firmware (BIOS/VPD) update procedure, perform the following steps:
1. To find documentation about the base HMC personal computer and its components, see “Equivalent

maintenance information for the HMC server hardware” on page 6.
2. Review the section in your HMC personal computer information for Updating the firmware.
3. Perform the procedures to update the new system board with the latest BIOS firmware.
4. Perform the procedures to update the vital product data (VPD) information with the machine type,

model, and serial number for the HMC.
5. Return the HMC to normal operations.

HMC diagnostics
Learn to use the HMC diagnostics when determining the state of or capability of a component found in
the HMC to perform its functions.

If a problem is determined to be in your HMC, read, understand, and then perform the procedures found
in this topic.

The HMC problem analysis procedure will guide you to the appropriate repair action. Occasionally, you
will be directed to the maintenance documentation for the HMC base server. When this occurs, the
maintenance documentation for the server is used to complete the repair action.

HMC system reference code

System reference codes (SRCs) are the foundation of the Hardware Management Console diagnostics.

All SRCs, also know as error codes, that pertain to the function of the HMC can be found in System
reference codes (Cxxx-Hxxx).

HMC connection error codes are 6 digits in length and begin with a 0, all other HMC error codes are 8
digits in length and begin with the alphabetic characters HSC. The HMC error codes are organized in the
following categories:
v 0xxxxx connection error codes
v HSCExxxx console events error codes
v HSCFxxxx Licensed Internal Code error codes
v HSCIxxxx Inventory Scout Services error codes
v HSCLxxxx partition and system management error codes
v HSCPxxxx platform management error codes
v HSCSxxxx Service Focal Point error codes
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Equivalent maintenance information for the HMC server hardware

Use the information provided to help cross-reference your HMC equivalent machine type and model
number for the base server. You can use the entries in this table to link directly to the base server
maintenance documentation.

Table 2. Equivalent maintenance information for server hardware used for each HMC model

HMC machine type and model
number (available on the serial
number plate of your HMC)

Equivalent server machine type and
model number

Hardware maintenance manuals
(HMM)

7042-C08 7946 Model 52U See Problem determination and
service guide

7042-CR5 7946 Model 52U or 7946 Model PAL See Problem determination and
service guide

7042-CR6 7944 Model PCH See Problem determination and
service guide

7042-CR7 and 7042-CR8 7914 Model PCH See Problem determination and
service guide

7042-CR9 5463 Model AC1 See Problem determination and
service guide

For the latest information regarding maintenance of your HMC server, system board specifications, and
parts, see server hardware maintenance manuals. To obtain the latest versions of these publications,
complete the following steps:
1. Go to the IBM Support Portal.
2. In the Product finder field, type the equivalent server machine type and model number that

corresponds to your HMC machine type and model number. Then, press enter.
3. Select the product that matches your equivalent server machine type and model. Click Operating

system independent. Then, click Go.
4. In the product support content area, click Troubleshooting documentation.
5. Select the problem determination and service guide.

Diagnostics, test, and recovery

Describes some of the diagnostic tools available for use on your HMC hardware related problems.

Choose from one of the following procedures to help in diagnosing a hardware related problem.
v Power-on self-test (POST)

– POST beep codes
– Error code format

Note: For more information about POST, see the appropriate server hardware maintenance
information. To access the server hardware maintenance information, see “Equivalent maintenance
information for the HMC server hardware.”

v Sector disk drive scanning procedure
To do a scan of your HMC disk drive, do the following:
1. Power® off the HMC.
2. Power on the HMC.
3. As the HMC is rebooting, watch the HMC display. After the second BroadCom Ethernet driver

screen is displayed, press CTRL+A.
4. From the list of options, select Disk Utilities.
5. Select Verify Disk Media. The HMC will perform a scan of your disk drive.

v Dynamic System Analysis
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Note: For more information about Dynamic System Analysis, see Diagnostic tools.

Connector and hard disk drive restrictions for the HMC

Identifies the connector and disk drive restriction found on your HMC.

Model 7042-CR5 have the following two hard disk drive restrictions:
v Use of the parallel port

Note: The HMC is a closed system and as such, the hardware is used in a limited manner. No device
drivers or code support any peripheral devices that use a parallel port.

v Use of more than one hard disk drive

To view the location of each HMC connector, see “Cabling the HMC” on page 33.

Hardware Management Console parts
Contains illustrations, part descriptions and part numbers that are used when ordering replacement parts
for your Hardware Management Console (HMC).

Server parts

Contains part number information for parts used in assembling your HMC.

Note: FRU parts and part numbers are subject to update due to our parts system substitution-update
policy. With our parts system substitution-update policy we make every effort to supply you with the
latest components available for your model HMC.

The following table contains a cross-reference equivalent of the HMC machine type and model number to
the server machine type and model number. For server parts information not listed in the following
tables, see hardware maintenance manual for your server.

Table 3. Equivalent maintenance information for server hardware used for each HMC model

HMC machine type and model
number (available on the serial
number plate of your HMC)

Equivalent server machine type and
model number

Hardware maintenance manuals
(HMM)

7042-C08 7946 Model 52U See Problem determination and
service guide

7042-CR5 7946 Model 52U or 7946 Model PAL See Problem determination and
service guide

7042-CR6 7944 Model PCH See Problem determination and
service guide

7042-CR7 and 7042-CR8 7914 Model PCH See Problem determination and
service guide

7042-CR9 5463 Model AC1 See Problem determination and
service guide

For the latest information regarding maintenance of your HMC server, system board specifications, and
parts, see server hardware maintenance manuals. To obtain the latest versions of these publications,
complete the following steps:
1. Go to the IBM Support PortalIBM Support Portal.
2. In the Product finder field, type the equivalent server machine type and model number that

corresponds to your HMC machine type and model number. Then, press enter.
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3. Select the product that matches your equivalent server machine type and model. Click Operating
system independent. Then, click Go.

4. In the product support content area, click Troubleshooting documentation.
5. Select the problem determination and service guide.

7042-C08 parts

Machine type 7042-C08 uses a server machine type of 7946-52U for its base configuration. To access the
server hardware maintenance manuals, see “Server parts” on page 10.

Note: Each server hardware maintenance manual might reference more than one machine type in its title.
If necessary, to cross-reference to the original server hardware maintenance manual, make sure that you
find the hardware maintenance manual for the server machine type and model for the HMC that you are
servicing.

The following illustration and table identifies the major components of the model 7042-C08.

Notes:

1. Field replaceable units (FRUs) must be serviced only by an authorized service provider.
2. Customer replaceable units (CRUs) can be replaced by the customer. Definitions of tier 1 and tier 2

CRUs for this model HMC follow:

Tier 1 CRU
A procedure that a customer can perform without input from a service provider. The
procedure used to service this type of component is usually required to be done by the
customer.

Tier 2 CRU
A procedure that a customer can perform, but might require support from a service provider.
The procedure used to service this component is not usually required to be done by the
customer.

3. If the part you are replacing is not identified as being either tier 1 or tier 2, call your service provider
to service the FRU.

Figure 9. Model 7042-C08 parts
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Table 4. 7042-C08 parts listing.

Index Description Tier 1
CRU

Tier 2
CRU

Part
number

1 Chassis assembly 49Y8457

2 Operator Information panel assembly 49Y8456

3 Front USB connector assembly 49Y8449

4 DVD-RAM Drive, SATA 43W8467

DVD-ROM Drive, SATA 43W8466

5 Bezel Kit 13N2450

6 Bezel, upper 49Y8453

7 Bezel, lower 49Y8454

8 Hard disk drive, SATA, 3.5- inch 250 GB, fixed/simple-swap, with tray
(optional)

39M4511

Hard disk drive, SATA, 3.5-inch 500 GB, fixed/simple-swap, with tray
(optional)

39M4517

Hard disk drive, 160 GB (optional) 39M4525

Hard disk drive, 250 GB SATA (optional) 39M4529

Hard disk drive, SATA, 3.5- inch 750 GB, fixed/simple-swap, with tray
(optional)

43W7575

Hard disk drive, SATA, 3.5-inch 500 GB, 10K, hot-swap, with tray
(optional)

39M4533

Hard disk drive, SATA, 3.5-inch 750 GB, 10K, hot-swap, with tray
(optional)

43W7579

Hard disk drive, SAS, 3.5-inch 146 GB, 15K, hot-swap, with tray
(optional)

39R7350

9 Retention bracket (front), adapter 13N2993

10 Hard disk drive cage, 3.5-inch drives 49Y8451

Hard disk drive cage, 2.5-inch drives 49Y8460

11 SAS/SATA hard disk drive backplane (for 3.5-inch drive cage) 49Y4462

SATA backplate, simple-swap 25R8842

12 Hard disk drive fan assembly (for 3.5-inch drive cage) 39Y9860

13 System board assembly 69Y1013

14 ServeRAID-BR10il v2 SAS/SATA controller 49Y4737

15 Microprocessor, Xeon 2.93 GHz, 1333MHz-9MB Processor 46C6775

Microprocessor, Xeon 2.4 GHz, 1333MHz-8MB, 4C, (models C2x and
C2Y)

49Y4647

Microprocessor, Xeon 2.53 GHz, 1333MHz-8MB, 4C, (models 42x and
42Y)

49Y4648

Microprocessor, Xeon 2.67 GHz, 1333MHz-8MB, 4C, (models 52x and
52Y)

49Y4649

Microprocessor, Xeon 2.8 GHz, 1333MHz-8MB, 4C, (models 62x and
62Y)

49Y4668

16 Fan sink 49Y8390

17 Side cover with lock 49Y8447

18 Retention bracket (rear), adapter 49Y8450
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Table 4. 7042-C08 parts listing (continued).

Index Description Tier 1
CRU

Tier 2
CRU

Part
number

19 Power supply, non-redundant 401 watt 46M6678

20 Memory, 1 GB single-rank PC3-10600R-999 DDR3 ECC RDIMM 44T1490

Memory, 2 GB single-rank PC3-10600R-999 DDR3 ECC RDIMM 44T1582

Memory, 2 GB dual-rank PC3-10600R-999 DDR3 ECC RDIMM 44T1491

Memory, 4 GB dual-rank PC3-10600R-999 DDR3 ECC RDIMM 44T1598

Memory, 1 GB dual-rank PC3-10600R-999 DDR3 ECC UDIMM 44T1572

Memory, 2 GB dual-rank PC3-10600R-999 DDR3 ECC UDIMM 44T1573

Memory, 2 GB single-rank PC3-10600R-999 DDR3 ECC UDIMM 44T1574

Memory, 4 GB quad-rank 1 Gbit DDR3-1066 RDIMM 46C7452

21 System fan, rear 49Y8445

The 7042-C08 parts that are listed in the following table are not illustrated.

Table 5. 7042-C08 parts listing (continued)

Description Tier 1 CRU Tier 2 CRU Part
number

ServeRAID-MR10i adapter 43W4296

ServeRAID-MR10is VAULT adapter 44E8695

NetXtreme II 1000 Express Ethernet Adapter 39Y6070

Cable, backplane configuration (3.5-inch hot-swap hard disk drive) 49Y8448

Cable, SAS signal (3.5-inch hot-swap hard disk drive) 46M6498

Cable, SATA signal (3.5-inch simple-swap hard disk drive) 49Y8444

Cable 1Mx4 SAS-Mini 39R6530

Cable 3Mx4 SAS-Mini 39R6532

Cable, optical disk drive/tape drive 25R5635

EMC shield 49Y8455

EMC shield kit, optical disk drive/tape drive 13N2997

Feet, chassis 13N2985

Hard disk drive carrier, 3.5-inch simple-swap 42C7495

Hard disk drive shield 44X0388

Keyboard, US 42C0060

Keylock, keyed-alike 26K7363

Keylock, keyed-random 26K7364

Kit, Retainer (for optical and diskette drives) 39R9369

Power supply unit adapter 42C7509

Miscellaneous parts kit 39Y9773

Mouse, 2-button 39Y9875

Mouse, optical, 3-button (optional) 40K9203

Power supply cage, 430 watt 49Y8459

Retention module (for fan sink) 49Y8458
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Table 5. 7042-C08 parts listing (continued) (continued)

Description Tier 1 CRU Tier 2 CRU Part
number

Side/top cover 49Y8446

System service label 49Y8452

USB hypervisor key 44M2234

Virtual media key 46C7532

Modem cable (see “HMC modem cable part numbers” on page 30)

For a more complete listing of power cords for the HMC, see Planning for power.

7042-CR5 parts

Models 7042-CR5 uses a server machine type of 7946 Model 52U for its base configuration. To access the
server hardware maintenance manuals, see “Server parts” on page 10.

Note: Each server hardware maintenance manual may reference more than one machine type in its title.
If necessary, to cross-reference to the original server hardware maintenance manual, make sure that you
find the hardware maintenance manual for the server machine type and model for the HMC that you are
servicing.

The following illustration and table identifies the major components of the model 7042-CR5.
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Notes:

1. Field replaceable units (FRUs) must be serviced only by an authorized service provider.
2. Customer replaceable units (CRUs) can be replaced by the customer. The CRUs are defined as either

Tier 1 or Tier 2 as follows:

Figure 10. Models 7042-CR5 parts illustration
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Tier 1 CRU
Procedure that a customer can perform without input from a service provider. The procedure
used to service this type of component is usually required to be done by the customer.

Tier 2 CRU
Procedure that a customer can perform, but may require support from a service provider. The
procedure used to service this component is usually not required to be done by the customer.

3. If the part you are replacing is not identified as being either Tier 1 or Tier 2, call your service provider
to service the FRU.

Table 6. 7042-CR5 Parts listing

Index Description Tier 1
CRUs

Tier 2
CRUs

FRU Part number

1 Top cover (All models) 43V6933

2 DIMM air duct 43V7050

3 PCI-X riser card assembly 43V7068

4 PCI Express riser card, x16, assembly 43V7066

5 Memory, 1 GB PC3-10600R-999 DDR3 ECC 44T1490

5 Memory, 2 GB PC3-10600R-999 DDR3 ECC 44T1491

5 Memory, 2 GB PC3-10600R-999 DDR3 ECC 44T1492

5 Memory, 4 GB PC3-10600R-999 DDR3 ECC 44T1493

5 Memory, 8 GB PC3-10600R-999 DDR3 ECC 46C7453

6 Virtual media key 46C7528

7 Power supply bay filler 49Y4821

8 Power supply, 675 Watt 39Y7201

9 Chassis assembly (without front bezel) 49Y4813

10 CD-RW/DVD drive 44W3255

10 CD-RW/DVD-RW drive 44W3256

11 Rack latch kit 49Y4815

12 Bezel 49Y4818

13 Operator information panel assembly 44E4372

14 Blank filler 49Y4821

15 Hard disk drive, 2.5-inch 50 GB simple-swap solid state 43W7733

16 Filler, hot-swap hard disk drive 44T2248

17 Hard disk drive, 2.5-inch, hot-swap 300 GB 10K 00E6167

19 Backplane, SAS hard disk drive 43V7071

20 Fan, hot-swap 40 mm 43V6929

21 System board 43V7072

22 ServeRAID-MR10i adapter 43W4297

23 ServeRAID-BR10i adapter 44E8690

24 SAS/SATA riser card 43V7067

25 Retention module, heat sink 49Y4822

26 Microprocessor, 1.86 GHz, 80W, (model 12x) 46D1272

26 Microprocessor, 2.00 GHz, 80W, (model 22x) 46D1271

26 Microprocessor, 2.13 GHz, 60W 46D1268
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Table 6. 7042-CR5 Parts listing (continued)

Index Description Tier 1
CRUs

Tier 2
CRUs

FRU Part number

26 Microprocessor, 2.13 GHz, 80W, (model 3Ax) 46D1270

26 Microprocessor, 2.26 GHz, 60W, (models 42x and 4Lx) 46D1269

Table 7. 7042-CR5 Parts listing (continued)

Index Description Units Part number

26 Microprocessor, 2.26 GHz, 80W, (model 32x) 46D1267

26 Microprocessor, 2.40 GHz, 60W 49Y6807

26 Microprocessor, 2.40 GHz, 80W, (models 52x and 54x) 46D1266

26 Microprocessor, 2.53 GHz, 80W, (models 62x and 64x) 46D1265

26 Microprocessor, 2.66 GHz, 95W, (models 74x and 76x) 46D1264

26 Microprocessor, 2.80 GHz, 95W, (model E3Y) 46D1263

26 Microprocessor, 2.93 GHz, 95W, (models 92x, 94x, and 96x) 46D1262

27 Heat sink assembly 49Y4820

28 Air baffle kit (Microprocessor air baffle, clamp, and DIMM air duct)
(all models)

43V6931

Cable management arm 49Y4817

Cable, hard disk drive configuration 43V7023

Cable, operator panel 46c4139

Cable, SAS power 46C4148

Cable, SAS signal, 120 mm 43V7019

Cable, SAS signal, 200 mm 43V6922

Cable, SAS signal, 300 mm 49Y4850

Cable, SATA DVD 43V6914

Cable, USB/video 43V6920

Cable assembly, simple-swap 43V7042

Cable, line cord, 2.8 m 39M5377

Cover, safety 240VA 49Y4823

DVD drive bay filler 49Y4868

EMC filler 44T2248

Ethernet card 43V7073

Labels, chassis 49Y4812

Labels, system service 46C6799

Low-profile adapter varies

Miscellaneous parts kit 49Y4814

Riser-card bracket: full-height, half-length 43V6936

Riser-card bracket: low-profile 43V6939

Bracket assembly, rear I/O 43V6938

SAS adapter retainer 49Y4852

ServeRAID-M5010 adapter 46M0851

ServeRAID-MR10i battery carrier kit 44E8763

Hardware Management Console service (Machine Type 7042) 17



Table 7. 7042-CR5 Parts listing (continued) (continued)

Index Description Units Part number

ServeRAID-MR10M battery carrier kit 44E8844

Video adapter, NVIDIA FX 1700 43V5765

Video adapter, NVIDIA FX 570 43V5782

7042-CR6 parts

Machine type 7042-CR6 uses a server machine type of 7944-PCH for its base configuration. To access the
server hardware maintenance manuals, see “Server parts” on page 10.

Note: Each server hardware maintenance manual might reference more than one machine type in its title.
If necessary, to cross-reference to the original server hardware maintenance manual, make sure that you
find the hardware maintenance manual for the server machine type and model for the HMC that you are
servicing.

The following illustration and table identifies the major components of the model 7042-CR6.

18 Hardware Management Console service (Machine Type 7042)



Notes:

1. Field replaceable units (FRUs) must be serviced only by an authorized service provider.
2. Customer replaceable units (CRUs) can be replaced by the customer. Definitions of tier 1 and tier 2

CRUs for this model HMC follow:

Figure 11. Model 7042-CR6 parts
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Tier 1 CRU
A procedure that a customer can perform without input from a service provider. The
procedure used to service this type of component is usually required to be done by the
customer.

Tier 2 CRU
A procedure that a customer can perform, but might require support from a service provider.
The procedure used to service this component is not usually required to be done by the
customer.

3. If the part you are replacing is not identified as being either tier 1 or tier 2, call your service provider
to service the FRU.

Table 8. 7042-CR6 parts listing

Index Description Tier 1
CRU

Tier 2
CRU

Part
number

1 Top cover 59Y3927

2 Filler, PCI 59Y3969

3 PCI-X riser card assembly 43V7068

4 PCI Express riser card, x16, assembly 43V7066

5 Memory, 2 GB single-rank DDR3-1333 RDIMM 49Y1444

6 Virtual media key 46C7528

7 Power supply bay filler (models A2x, B2x, C2x, D2x, G2x, H2x, J2x,
M2x, and N2x)

49Y4821

8 Power supply, 675 Watt, ac 39Y7201

9 Chassis assembly (without front bezel) 59Y3931

10 DVD-RW drive 44W3256

11 Rack latch kit 49Y4815

12 Bezel, 8 hard disk bays 59Y3916

12 Bezel, 4 hard disk and 1 optical drive bays 59Y3917

13 Operator information panel assembly 44E4372

14 Filler, hard disk drive bay 59Y3925

15 Not applicable to this model

16 Filler, EMC 44T2248

17 Hard disk drive, 2.5-inch hot-swap, 500 GB, 10 K 42D0753

18 Backplate assembly, simple-swap 59Y3919

19 Backplane, SAS 59Y3915

20 Fan 43V6929

21 System board 59Y3793

22 ServeRAID-M1015 adapter (models B2x, C2x, D2x, H2x, and N2x) 46M0861

23 ServeRAID-BR10il v2 adapter (model A2x) 49Y4737

24 SAS/SATA riser card 43V7067

25 Retention module, heat sink 49Y4822

26 Microprocessor, 2.53 GHz 80W (model F2x) 49Y7052

27 Heat sink assembly (models A2x, B2x, C2x, D2x, F2x, G2x, H2x, J2x,
and M2x)

49Y4820

28 Air baffle kit (Microprocessor air baffle, clamp, and DIMM air duct)
(all models)

59Y3914
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Table 8. 7042-CR6 parts listing (continued)

Index Description Tier 1
CRU

Tier 2
CRU

Part
number

29 DIMM air duct 43V7050

The 7042-CR6 parts that are listed in the following table are not illustrated.

Table 9. 7042-CR6 parts listing (continued)

Description Tier 1 CRU Tier 2 CRU Part
number

Cable, hard disk drive configuration 59Y3918

Cable, operator panel 46C4139

Cable, SAS power 59Y3920

Cable, SAS signal, 300 mm 49Y4850

Cable, SATA DVD 59Y3922

Cable, USB/video 59Y3923

Cable, line cord (models A2x, B2x, C2x, D2x, F2x, G2x, H2x, J2x, M2x, and
N2x)

39M5377

Cage, hard disk drive 59Y3968

Cage, optical drive 59Y3924

Safety cover 49Y4823

Filler, DVD drive bay 49Y4868

2-port 1 Gb Ethernet card 69Y4509

2-port 1 Gb Ethernet card, mechanical kit 69Y4586

Labels, chassis 59Y3998

Labels, system service 59Y3926

Miscellaneous parts kit 69Y4506

Riser-card bracket: full-height, half-length 43V6936

Riser-card bracket: low-profile (models J2x and M2x) 43V6939

Bracket assembly, rear I/O 43V6938

SAS adapter retainer 49Y4852

Slide rail kit 59Y3792

CMA kit 49Y4817

Slide rail kit, Gen-II 69Y4391

CMA kit, Gen-II 69Y4392

Screw kit 59Y4922

Thermal grease kit 41Y9292

Hypervisor, embedded USB flash device 42D0545

Alcohol wipes 59P4739

For a more complete listing of power cords for the HMC, see Planning for power.
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7042-CR7 or 7042-CR8

Machine type 7042-CR7 or 7042-CR8 uses a server machine type of 7914-PCH for its base configuration.
To access the server hardware maintenance manuals, see “Server parts” on page 10.

Note: Each server hardware maintenance manual might reference more than one machine type in its title.
If necessary, to cross-reference to the original server hardware maintenance manual, ensure that you find
the hardware maintenance manual for the server machine type and model for the HMC that you are
servicing.

The following illustration and table identifies the major components of the model 7042-CR7 or 7042-CR8.
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Notes:

1. Field replaceable units (FRUs) must be serviced only by an authorized service provider.

Figure 12. Model 7042-CR7 or 7042-CR8 parts
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2. Customer replaceable units (CRUs) can be replaced by the customer. Definitions of tier 1 and tier 2
CRUs for this model HMC follow:

Tier 1 CRU
A procedure that a customer can perform without input from a service provider. The
procedure used to service this type of component is usually required to be done by the
customer.

Tier 2 CRU
A procedure that a customer can perform, but might require support from a service provider.
The procedure used to service this component is not usually required to be done by the
customer.

3. If the part you are replacing is not identified as being either tier 1 or tier 2, call your service provider
to service the FRU.

Index Description CRU part
number
(Tier 1)

CRU part
number
(Tier 2)

Part
number

1 Top cover 94Y7569

2 Air baffle 94Y7568

3 PCI bracket 2 94Y7566

3 PCI-X riser card 94Y7590

4 PCI Express riser card, Gen3 x16 94Y7588

5 Filler, PCI 94Y7608

6 Memory, 8 GB dual-rank 1.35 V, DDR3, 1333 MHz, RDIMM
Note: This part number applies only to 7042-CR7.

49Y1415

6 Memory, 8 GB single-rank 1.35 V, DDR3, 1600MHz, RDIMM
Note: This part number applies only to 7042-CR8.

00D5038

7 Power supply bay filler 94Y7610

8 Power supply, 550 W, ac 43X3312

9 Chassis assembly, 2.5-inch hard disk drive (HDD) (without front
bezel)

94Y7573

10 DVD-RW drive 44W3256

11 Operator information panel assembly 90Y5821

11 Operator information panel assembly, advanced 90Y5822

USB assembly, front 94Y7621

USB assembly, front dual-port 00D3338

12 Not applicable to this model

13 Not applicable to this model

14 Not applicable to this model

15 HDD, 2.5-inch hot-swap, 500 GB, 7.2 K 81Y9727

16 EIA bracket 94Y7570

17 Not applicable to this model

18 Backplane, 2.5-inch hot-swap HDD 94Y7587

19 Fan module, hot-swap 94Y7564

20 System board 00Y8375

21 ServeRAID M5110 SAS/SATA adapter 81Y4482

21 ServeRAID M5100 series 512 MB flash (RAID 5 upgrade) 81Y4488
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Index Description CRU part
number
(Tier 1)

CRU part
number
(Tier 2)

Part
number

21 ServeRAID M5110 series battery Kit 81Y4491

22 Retention module, heat sink 94Y7739

23 Microprocessor installation tool 94Y9955

23 Microprocessor, Intel Xeon E5-2640, 2.50 GHz, 15 MB, 1333 MHz, 95
W (6-core)
Note: This part number applies only to 7042-CR7.

81Y5166

23 Microprocessor, Intel Xeon E5-2640, 2.0 GHz, 20 MB, 1600 MHz, 95
W (8-core)
Note: This part number applies only to 7042-CR8.

00Y2782

24 Heat sink assembly, 95 W 94Y7602

The 7042-CR7 or 7042-CR8 parts that are listed in the following table are not illustrated.

Description CRU part
number
(Tier 1)

CRU part
number
(Tier 2)

Part
number

Battery, 3.0 V 33F8354

Battery, ServeRAID 81Y4579

Cable, power cord 39M5377

Cable, mini SAS 1 meter (3.3 feet) 39R6530

Cable, USB 81Y6659

Cable, USB conversion 39M2909

Cable, serial conversion 46M4027

Cable, virtual media Gen 2 46M4028

Cable, power, 2.5-inch HDD 81Y6663

Cable, backplane, 2.5-inch hot-swap HDD 81Y6667

Cable, operator information panel 81Y6669

Cable, SATA DVD 81Y6671

Cable, video 81Y6673

Cable, adapter power 81Y6676

Cable, ServeRAID battery 90Y7309

Cable, ServeRAID power module 90Y7310

Cable, SPECpower 00D3334

Panel, light path diagnostics 00D3863

Labels, chassis 94Y7604

Labels, system service 94Y7605

Bezel, 2.5-inch hard disk bays, and 1 optical drive bay 94Y7606

Thermal grease kit 41Y9292

Alcohol wipes 59P4739

Miscellaneous parts kit 94Y7571

Filler, EMC 44T2248

Filler, DVD drive bay 49Y4868
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Description CRU part
number
(Tier 1)

CRU part
number
(Tier 2)

Part
number

Filler, HDD bay 59Y3925

Filler, fan 94Y7572

Remote RAID battery tray 94Y7609

CMA kit 49Y4817

Slide rail kit, Gen-III 94Y6625

CMA kit, Gen-III 94Y6626

Slide rail kit, universal 94Y6719

For a complete listing of power cords for the HMC, see Planning for power.

7042-CR9 parts

Machine type 7042-CR9 uses a server machine type of 5463-AC1 for its base configuration. To access the
server hardware maintenance manuals, see “Server parts” on page 10.

Note: Each server hardware maintenance manual might reference more than one machine type in its title.
If necessary, to cross-reference to the original server hardware maintenance manual, ensure that you find
the hardware maintenance manual for the server machine type and model for the HMC that you are
servicing.

The following illustration and table identifies the major components of the model 7042-CR9.
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Notes:

1. Field replaceable units (FRUs) must be serviced only by an authorized service provider.
2. Customer replaceable units (CRUs) can be replaced by the customer. Definitions of tier 1 and tier 2

CRUs for this model HMC follow:

Tier 1 CRU
A procedure that a customer can perform without input from a service provider. The
procedure used to service this type of component is usually required to be done by the
customer.

Tier 2 CRU
A procedure that a customer can perform, but might require support from a service provider.
The procedure used to service this component is not usually required to be done by the
customer.

Figure 13. Model 7042-CR9 parts
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3. If the part you are replacing is not identified as being either tier 1 or tier 2, call your service provider
to service the FRU.

Index Description CRU part
number
(Tier 1)

CRU part
number
(Tier 2)

Part
number

1 Top cover 00KF667

2 Power supply bay filler 94Y7610

3 Power supply, 550 Watt, high efficiency, platinum, ac 94Y8137

3 Power supply, 550 Watt, high efficiency, platinum, ac 94Y8139

3 Power supply, 550 Watt, high efficiency, platinum, ac 94Y8173

4 Heat sink 00KC912

5 Microprocessor, Intel E5-2620 v3, 2.4 GHz, 15 MB, 1866 MHz, 85 W
(6-core)

00AE690

6 System board 00MV248

7 Memory, 16 GB, 2Rx4, 1.2 V, DDR4, 2133MHz, RDIMM 46W0798

8 Not applicable to this model

9 Not applicable to this model

10 Not applicable to this model

11 Not applicable to this model

12 LCD system information display panel 00D0464

13 Media cage, eight 2.5-inch hard disk drives 00KF670

14 Not applicable to this model

15 Ultraslim enhanced SATA multi-burner 00FL353

16 Hard disk drive, 2.5-inch hot-swap, Near-Line SATA, 500 GB, 7.2 K 00AJ137

17 Filler, 2.5-inch hard disk drive bay 00FW856

17 Filler, 2.5-inch hard disk drive bay (rear) 00KF683

18 Backplane, four 2.5-inch hard disk drives 00FJ755

19 Battery holder 00KF677

20 Not applicable to this model

21 Air baffle, 2.5-inch hard disk drive bay 00KF666

The 7042-CR9 parts that are listed in the following table are not illustrated.

Description CRU part
number
(Tier 1)

CRU part
number
(Tier 2)

Part
number

Front USB assembly, eight 2.5-inch hard disk drives 00KF674

ServeRAID M5210 SAS/SATA Controller 46C9111

ServeRAID M5200 series 1 GB flash (RAID 5 upgrade) 47C8661

ServeRAID M5200 power card

Cable, backplane, four 2.5-inch hot-swap hard disk drive 00KC960

Operator information panel, 2.5-inch hard disk drive bay 00KF673

PCIe Riser 1, low-profile bracket 00KF687

PCIe Riser 2, 2 x low-profile bracket 00KF688
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Description CRU part
number
(Tier 1)

CRU part
number
(Tier 2)

Part
number

Bezel, eight 2.5-inch hard disk drives (no LCD system information display
panel)

00KF672

Bracket, four 2.5-inch backplane 00KF692

Filler, thermal kit (hot-swap fan) 00KF682

Alcohol wipes 59P4739

Cable, SAS 750 mm 00KC952

Cable, DVD 480 mm 00KC958

Miscellaneous parts kit 00KF685

Cable, video 2.5 inches 00KG408

Cable, LCD system information display panel 00MU415

Battery, 3.0 volt 33F8354

Thermal grease kit 41Y9292

Cable, flash power module 46C9793

Power card 00JY023

For a complete listing of power cords for the HMC, see Planning for power.

HMC keyboard CRUs

The keyboards identified in the following table can be attached to any HMC.

Notes:

1. All keyboards are considered a Tier 1 CRU.
2. You must have the specific character set designed for each language installed on your HMC.

Keyboard country code FRU/CRU part number

US English 10N6956

Arabic 10N6984

Belgian/French 89P8302

Belgian/UK 10N6969

Bulgarian 10N6972

Brazilian Portuguese 10N6963

Chinese/US 10N6966

Czech 10N6981

Danish 10N6971

Dutch 10N6975

English/EMEA 10N6988

French 10N6957

French Canadian 445 10N6967

French Canadian 58 10N6968

German 10N6959

Greek 10N6977
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Keyboard country code FRU/CRU part number

Hebrew 10N6978

Hungarian 10N6964

Icelandic 89P8317

Italian 141 89P8318

Italian 142 10N6958

Japanese 194 10N6962

Korean 10N6965

LA Spanish 10N6983

Norwegian 10N6974

Polish 10N6979

Portuguese 10N6976

Romanian 89P8326

Russian 10N6986

Russian/Cyrillic 89P8328

Serbian/Cyrillic 89P8329

Slovak 10N6980

Spanish 10N6961

Swedish/Finnish 10N6870

Swiss/French/German 10N6973

Thailand 89P8334

Turkish 440 10N6982

Turkish 179 89P8336

UK English 10N6960

US 89P8338

Yugoslav/Latin 89P8339

HMC modem cable part numbers

The following tables contain part number information for HMC modem cables, along with the name of
the country or region where used, and a listing of countries along with the telephone cable name and
part number where used.

If you are using a cable other than one of the cables listed in the following table, read the following
caution statement.

Note: For a more complete listing of power cords for the HMC, see Planning for power.

CAUTION:
To reduce the risk of fire, use only No. 26 AWG or larger (for example, 24 AWG) UL-listed or CSA
certified telecommunication line cord. (C035)

Primary country or region Cable name Cable part number

Austria AUS 21H4902

Australia AUZ 75G3807
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Primary country or region Cable name Cable part number

Belgium BEL 21H4903

Denmark DN 75G3812

Finland FN 75G3809

France FR 75G3803

Germany GE 75G3804

Hong Kong S.A.R. of the PRC HK 75G3808

Israel ISR 21H4905

Italy IT 75G3802

Netherlands NL 75G3810

South Africa SAF 21H4904

Sweden SW 75G3806

Switzerland SZ 75G3811

United Kingdom UK 75G3805

United States US 87G6236

External modems

Contains a list of external modem part number along with the primary country or region where used.

Note: 7042-CR8 and 7042-CR9 do not support external modems.

Primary country or region Modem part number

United States 03N7035

Australia 03N7036

Europe 03N7037

United Kingdom 03N7038

China 03N7039

Taiwan 03N7040

All geographies 03N7041

Internal modem

When ordering a replacement internal modem for HMC model 7042-CR5, 7042-CR6, use part number
45D3866. For other HMC models, use part number 80P4702.

Note: 7042-CR7, 7042-CR8, and 7042-CR9 do not support internal modems.

Power cords

The manufacturer provides a power cord with a grounded attachment plug to use with this product. To
avoid electrical shock, always use the power cord and plug with a properly grounded outlet.

Power cords used in the United States and Canada are listed by Underwriter's Laboratories (UL) and
certified by the Canadian Standards Association (CSA).
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v For units intended to be operated at 115 volts: Use a UL-listed and CSA-certified cord set consisting of
a minimum 18 AWG, Type SVT or SJT, three-conductor cord, a maximum of 15 feet in length and a
parallel blade, grounding-type attachment plug rated 15 amperes, 125 volts.

v For units intended to be operated at 230 volts (within the US): Use a UL-listed and CSA-certified cord
set consisting of a minimum 18 AWG, Type SVT or SJT, three-conductor cord, a maximum of 15 feet in
length and a tandem blade, grounding-type attachment plug rated 15 amperes, 250 volts.

v For units intended to be operated at 230 volts (outside the US): Use a cord set with a grounding-type
attachment plug. The cord set should have the appropriate safety approvals for the country in which
the equipment will be installed.

v The power cords listed in the following table are specifically designed for a country or region and are
usually available only in that country or region.

Note: All power cords are considered a Tier 1 CRU.

Index Power cord part number Used in these countries and regions

1 1838574 Thailand, Bahamas, Barbados, Bolivia, Brazil, Canada, Costa Rica,
Dominican Republic, Ecuador, El Salvador, Guatemala, Guyana, Haiti,
Honduras, Jamaica, Japan, Netherlands Antilles, Panama, Peru, Philippines,
Taiwan, Trinidad (West Indies), Tobago, United States of America,
Venezuela

2 6952301 Bahamas, Barbados, Bermuda, Bolivia, Brazil, Canada, Cayman Islands,
Colombia, Costa Rica, Dominican Republic, Ecuador, El Salvador,
Guatemala, Guyana, Haiti, Honduras, Jamaica, Japan, Korea (South),
Liberia, Mexico, Netherlands Antilles, Nicaragua, Panama, Peru,
Philippines, Saudi Arabia, Suriname, Taiwan, Trinidad (West Indies),
United States of America, Venezuela

3 13F9940 Argentina, Australia, China (PRC), New Zealand, Papua New Guinea,
Paraguay, Uruguay, Western Samoa
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Index Power cord part number Used in these countries and regions

4 13F9979 Afghanistan, Algeria, Andorra, Angola, Austria, Belgium, Benin, Bulgaria,
Burkina Faso, Burundi, Cameroon, Central African Rep., Chad, Czech
Republic, Egypt, Finland, France, French Guiana, Germany, Greece, Guinea,
Hungary, Iceland, Indonesia, Iran, Ivory Coast, Jordan, Lebanon,
Luxembourg, Macao S.A.R. of the PRC, Malagasy, Mali, Martinique,
Mauritania, Mauritius, Monaco, Morocco, Mozambique, Netherlands, New
Caledonia, Niger, Norway, Poland, Portugal, Romania, Senegal, Slovakia,
Spain, Sudan, Sweden, Syria, Togo, Tunisia, Turkey, former USSR, Vietnam,
former Yugoslavia, Zaire, Zimbabwe

5 13F9997 Denmark

6 14F0015 Bangladesh, Burma, Pakistan, South Africa, Sri Lanka

7 14F0033 Antigua, Bahrain, Brunei, Channel Islands, Cyprus, Dubai, Fiji, Ghana,
Hong Kong S.A.R. of the PRC, India, Iraq, Ireland, Kenya, Kuwait, Malawi,
Malaysia, Malta, Nepal, Nigeria, Polynesia, Qatar, Sierra Leone, Singapore,
Tanzania, Uganda, United Kingdom, Yemen, Zambia

8 14F0051 Liechtenstein, Switzerland

9 14F0069 Chile, Ethiopia, Italy, Libya, Somalia

10 14F0087 Israel

Cabling the HMC
Connect the Hardware Management Console (HMC) cables, connect the Ethernet cable, and connect the
HMC to a power source.

If the physical HMC is not located within 8 meters (25 feet) away from the managed system, you must
supply a separate system that can access the Internet using a browser. This system must be within 8
meters (25 feet) of the managed system. This setup allows service personnel remote access to the HMC.
The HMC must also be configured to allow for this remote access.
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DANGER

Electrical voltage and current from power, telephone, and communication cables are hazardous.

To avoid a shock hazard:

v Do not connect or disconnect any cables or perform installation, maintenance, or reconfiguration
of this product during an electrical storm.

v Connect all power cords to a properly wired and grounded electrical outlet. Ensure outlet
supplies proper voltage and phase rotation according to the system rating plate.

v Connect any equipment that will be attached to this product to properly wired outlets.

v When possible, use one hand only to connect or disconnect signal cables.

v Never turn on any equipment when there is evidence of fire, water, or structural damage.

v Disconnect the attached power cords, telecommunications systems, networks, and modems before
you open the device covers, unless instructed otherwise in the installation and configuration
procedures.

v Connect and disconnect cables as described below when installing, moving, or opening covers on
this product or attached devices.

To Disconnect:

1. Turn everything OFF (unless instructed otherwise).

2. Remove power cords from the outlet.

3. Remove signal cables from connectors.

4. Remove all cables from devices.

To Connect:

1. Turn everything OFF (unless instructed otherwise)

2. Attach all cables to devices.

3. Attach signal cables to connectors.

4. Attach power cords to outlet.

5. Turn device ON.

(D005)

Use the following instructions to help you cable your rack-mounted or stand-alone HMC.

Attention: Do not plug the power cords into the electrical outlet until you are instructed to do so.
1. Ensure that you position the HMC in the correct location.
2. Choose from the following options:
v If you are installing a rack-mounted HMC, continue with step 3.
v If you are installing a stand-alone HMC, continue with step 4 on page 36.

3. Perform the following steps to install the cables on a rack-mounted HMC:
a. Use the following illustration to identify the location of the connectors described in these

instructions:
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Figure 14. Rear view of a typical rack-mounted HMC

Figure 15. Rear view of 7042-CR5 model

Figure 16. Rear view of a 7042-CR7 or 7042-CR8
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b. If you are installing your HMC into a rack, see Installing and configuring the Hardware
Management Console. When you have finished installing the HMC into a rack, continue with the
next step.

c. Connect the keyboard, display, and mouse using the USB conversion option cable.
d. Continue with step 5 on page 37.

4. If you are installing a stand-alone HMC, perform the following steps:
a. Use the following illustration to identify the location of the connectors described in these

instructions:

Table 10. Supported HMC ports

Port Description

Video The Video port is used as monitor connection.

Figure 17. Rear view of a 7042-CR9 model

Figure 18. Rear view of a typical stand-alone (tower) HMC

36 Hardware Management Console service (Machine Type 7042)

http://www.ibm.com/support/knowledgecenter/POWER8/p8hai/p8hai_kickoff.htm
http://www.ibm.com/support/knowledgecenter/POWER8/p8hai/p8hai_kickoff.htm


Table 10. Supported HMC ports (continued)

Port Description

PS/2 Keyboard/Mouse A PS/2 keyboard or mouse is not included with the
HMC, but you can attach either.

Serial 1 Serial 1 is supported for an external modem.

USB These ports are supported for a USB keyboard, mouse,
flash memory, or USB diskette drive.

Ethernet The Ethernet port is used as the HMC's primary network
connection.

The HMC does not support the use of parallel or Serial 2 ports.
b. Attach the monitor cable to the monitor connector, and tighten the screws.
c. Attach the power cord to the monitor.
d. Ensure that the voltage selection switch on the HMC is set to the voltage used in your world

region. The voltage selection switch is red and is located near the power connector. Move the
switch so that the voltage used in your world region is displayed.

e. Plug the power cord into the HMC.
f. Connect the keyboard and mouse to the Universal Serial Bus (USB) ports on the HMC. You can

connect the keyboard and mouse to the USB ports on the front or rear panels.
5. Connect the modem:

Note: During the installation and configuration of the HMC, the modem might automatically dial
out as the HMC follows routine call-out procedures. This is usual behavior.
If you are connecting an external modem, do the following:
a. Optional: Install the external modem into a rack.
b. If you have not already done so, connect the modem data cable to the external HMC modem.
c. Connect the modem data cable to the system port on the HMC labeled with the following symbol:

d. Use the telephone cable to connect the line port of the external modem to the analog telephone
jack on your wall.

If you are connecting to an integrated modem, use the data cable to connect the integrated HMC modem
to the appropriate data source. For example, use the telephone cable to connect the HMC modem line
port to the analog jack on your wall.

6. Connect the Ethernet (or crossover) cable from the HMC to the managed server.

Note:

v In general, connect your HMC to the managed server in a private service DHCP network. If you
have not installed any additional Ethernet adapters in the PCI slots on your HMC, use the primary
integrated Ethernet port. Use the previous illustrations to identify the location of the HMC ports.

v You can verify that the Ethernet cable connection is active by observing the green status lights at
both the HMC and managed system Ethernet ports while your installation progresses.

v Connect the Ethernet port on the HMC to the Ethernet port that is labeled HMC1 on the managed
server.
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If you are connecting a second HMC to your managed server, connect to the Ethernet port that is
labeled HMC2 on the managed server.

7. If you use an external modem, plug the modem power supply cord into the HMC modem.
8. Plug the power cords for the monitor, HMC, and HMC external modem into electrical outlets.

Note: Do not connect the managed system to a power source at this time.
9. If you are setting up the HMC to manage an existing server, continue with “Preparing for HMC

configuration” on page 70.

Note: For a complete list of HMC supported external cables, see Serial attached SCSI cable planning
topic.

Troubleshooting the HMC
Learn how to correct a No connection, Incomplete, Recovery, or Error state on a system managed by an
HMC.

Correcting a No connection state for a managed system
The No connection state can occur when the HMC is not connected, or the connection with the managed
system failed.

Use this procedure for a system that was previously connected to the same HMC and is now in No
connection state. If you have a new system, a new HMC, or have moved your system to a different HMC,
see “Correcting a connection problem between the HMC and a managed system” on page 43.
1. Obtain the IP address for the managed system's service processor by performing the following steps.

a. On the HMC, right-click the desktop and select terminal > xterm. The restricted shell command
line interface opens.

b. At the terminal, issue the command: lssysconn -r all
Information similar to the following is displayed:
resource_type=sys,type_model_serial_num=9117-570*100729E,sp=unavai
lable,ipaddr=10.0.0.247,alt_ipaddr=unavailable,state=No Connection,conne
ction_error_code=Connecting 0000-0000-00000000

c. At the terminal, issue the ping command to the address of the failing system. In the previous
example, you would type: ping 10.0.0.247.

2. Choose from the following options:
v If the ping is successful, go to step 3.
v If the ping is not successful, go to step 4.

3. If the ping test is successful, perform the following steps:
a. If your system is equipped with a control panel, ensure that there are no steady (nonscrolling)

reference codes displayed on the panel.

Note: A steady reference code might indicate a hardware problem. Contact your next level of
support or your hardware service provider.

b. Restart the HMC. For instructions about restarting the HMC, see “Shutting down, restarting,
logging off, and disconnecting the HMC” on page 71.

c. If restarting the HMC does not resolve the problem, contact your next level of support or your
hardware service provider.

4. If the ping test is not successful, perform the following steps:
a. If your system is equipped with a control panel, ensure that there are no steady (nonscrolling)

reference codes displayed on the panel.
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Note: A steady reference code might indicate a hardware problem. Contact your next level of
support or your hardware service provider.

b. If your system has a control panel, check to see if the power light is on.
c. Choose from the following options:
v If there is power to the managed system, go to step 5.
v If there is no power to the managed system, see “HMC and system power-on and power-off

procedures” on page 47. After the power is restored, wait 5 minutes for the service processor to
restart and the HMC to re-establish contact. If the system is equipped with redundant service
processors, allow up to 20 minutes for this step.

5. Verify physical network connectivity by performing the following steps:
a. Verify that the HMC and the service processor are correctly connected to your Ethernet network.
b. Verify that Ethernet link status is good on all network segments which exist between the HMC

and the managed system.
c. If you think the network might be the problem, connect a cable from the HMC to the service

processor and try pinging the failing system. Then choose from the following options:
v If the ping is successful, replace the cables the way they were and correct the network problem.

After the network problem is resolved, repeat this entire procedure.
v If the ping is not successful, replace the cables the way they were and continue with step 5d.

d. Reset the service processor. See “Resetting the service processor” on page 46.
6. If the problem is not resolved by any of the above steps, contact your next level of support or your

hardware service provider.

Correcting an Incomplete state for a managed system
The Incomplete state can occur when the Hardware Management Console (HMC) failed to get all of the
necessary information from the managed system.

To correct an Incomplete state, perform the following steps:
1. Choose one of the following navigation options depending on the interface type of the HMC:
v If you are using an HMC Classic or HMC Enhanced interface, complete the following steps:

a. In the navigation area, select Systems Management > Servers.
b. In the contents pane, select the required managed system.
c. Select Tasks > Operations > Rebuild.
d. Select Yes to refresh the internal representation of the managed system.

v If you are using an HMC Enhanced + Tech Preview (Pre-GA) interface, complete the following
steps:

a. In the navigation area, click the Resources icon , and then select All Systems.
b. In the content pane, select the system name that contains the partition, and then select the

partition.
c. In the navigation area, select System Actions > Operations > Rebuild System.
d. Select Yes to refresh the internal representation of the managed system.

2. Choose from the following options:
v If the state remains as Incomplete, rebuild the managed system several more times.
v If the state goes to Recovery, see “Correcting a Recovery state for a managed system” on page 40.
v If the state does not remain as Incomplete or go to Recovery, continue with the next step.
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3. Reset the connection from the HMC. See “Resetting the managed system connection from the HMC”
on page 46. If the connection still fails, continue with the next step.

4. Restart the HMC. Then choose from the following options (This next step might take several minutes
to complete):
v If the state goes to Recovery, see “Correcting a Recovery state for a managed system.”
v If the state remains Incomplete, perform the following steps:

a. Verify that there is a redundant HMC.
b. Verify that no one is entering commands from the alternate HMC.
c. Repeat step 1 on page 39 through 4. If the connection still fails, continue with the next step.

5. If the problem persists, contact your next level of support or your hardware service provider.

Correcting a Recovery state for a managed system
The Recovery state can occur when the save area in the service processor assembly is not synchronized
with the HMC database.

To recover from the Recovery state, perform the following steps:
1. Recover partition data. For more information, see “Recovering partition data on a managed system.”

If this resolves the problem, this ends the procedure.
2. If the problem is not resolved after recovering profile data, choose one of the following:
v If the state remains in Recovery , retry recovering partition data. If it fails a second time, follow the

problem determination procedure for any reference codes you receive.
v If the state changed to Incomplete, see “Correcting an Incomplete state for a managed system” on

page 39.
v If the state changed to No Connection, see “Correcting a No connection state for a managed system”

on page 38.
v If the problem persists, contact your next level of support or your hardware service provider.

Recovering partition data on a managed system
Learn how to recover the partition data on your managed system if the partition becomes corrupted.

Through the Hardware Management Console (HMC) interface, you can recover partition data on your
managed system if the data becomes damaged. This partition data includes information about logical
partitions, partition profiles, and system profiles. If the partition data on your managed system becomes
damaged, the managed system is in Recovery state. You can either restore the partition data from a
backup file that is saved automatically on your HMC, or clear all partition configuration.

This procedure recovers the partition data that is saved automatically in the service processor of your
server. To recover the partition data from a specific version of the backup data on your managed system,
use this procedure to restore or initialize the partition data, and then restore the profile data from the
backup file. For information about how to restore profile data from a backup file, see “Restoring profile
data” on page 41.

Note: The HMC might not show operating state for the managed system after completing this recovery
procedure. After a partition is activated, the managed system changes to an operating state and clears the
A700 4091 or C700 4091 system reference code (SRC).

To recover the partition data on your managed system, you must be a member of one of the following
roles:
v Super administrator
v Operator
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Attention: The bootlists of all logical partitions are lost during this procedure, and the HMC rebuilds
default bootlists for the logical partitions. If a logical partition uses a mirrored system boot disk, you
must re-create the bootlist for the logical partition before you start the operating system on the logical
partition.

To recover the partition data on your managed system, choose one of the following navigation options
depending on the interface type of the HMC:
v If you are using an HMC Classic or HMC Enhanced interface, complete the following steps:

1. In the navigation area, click Systems Management > Servers.
2. In the content pane, select the required managed system.
3. Click Tasks > Configuration > Manage Partition Data, and then select one of the following

options:
– Restore: This option restores the partition data by using the backup file that is saved

automatically on the HMC.
– Initialize: This option clears all partition configuration data. This option can be used only if all

partitions are in the Not Activated state.
4. Click OK.

v If you are using an HMC Enhanced+ interface, complete the following steps:

1. In the navigation area, click the Resources icon , and then click All Systems.
2. In the content pane, select the system name that contains the partition.
3. In the navigation area, click System Actions > Legacy, and then select one of the following options:

– Restore: This option restores the partition data by using the backup file that is saved
automatically on the HMC.

– Initialize: This option clears all partition configuration data. This option can be used only if all
partitions are in the Not Activated state.

4. Click OK.

Restoring profile data
Learn how to read the profile data from the previously backed-up file on the Hardware Management
Console (HMC), and load this data to the managed system.

Selecting this menu item restores profile data to the HMC from a backup file stored on the HMC hard
drive.

Note: This is not a concurrent procedure. To restore profile data, the managed system must be in a
partition standby or operating state. After the data is restored, the managed system powers on to the
partition standby state.

To restore stored profile data on the HMC hard drive, you must be a member of one of the following
roles:
v Super administrator
v Service representative

To restore profile data, choose one of the following navigation options. The option that you choose
depends on the interface type of the HMC:
v If you are using an HMC Classic or HMC Enhanced interface, complete the following steps:

1. In the navigation area, click Systems Management > Servers.
2. In the content pane, select the required managed system.
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3. Click Tasks > Configuration > Manage Partition Data > Restore.
4. From the list of backup files, select the profile information that you want to restore.
5. Select a restore option.
6. Click OK.

v If you are using an HMC Enhanced+ interface, complete the following steps:

1. In the navigation area, click the Resources icon , and then click All Systems.
2. In the content pane, select the system name that contains the partition.
3. In the navigation area, click System Actions > Legacy > Restore.
4. From the list of backup files, select the profile information that you want to restore.
5. Select a restore option.
6. Click OK.

Correcting an Error state for a managed system
The Error state automatically generates a call to the service support center if the automatic call support
function is enabled.

If the automatic call support function is not enabled, contact your next level of support or your hardware
service provider.

Correcting a Failed Authentication state for a managed system
The Failed Authentication state can occur when the HMC access password for the managed system is not
valid.

Perform the following procedure to correct a failed authentication state on your HMC.
1. Do you have an HMC password?
v Yes: Enter the HMC password and choose from the following options:

– If the managed system goes to Operating, Power Off, or Standby, the authentication was
successful. This ends the procedure.

– If the managed system goes to No connection, Incomplete, Recovery, or Error state, see
“Troubleshooting the HMC” on page 38.

v No: Do you have an ASMI admin password?
– Yes: Continue with step 2.
– No: Contact your next level of support to request CE login. Then continue with step 2, using CE

login instead of admin password for step 2a.
2. Perform the following steps:

a. Log in to the ASMI with admin authority.
b. Select Login Profile.
c. Select Change Password.
d. In the User ID to change field, select HMC.
e. Enter the ASMI's admin password in the Current Password for user ID admin field.

Note: Do not enter the HMC user password. Enter the ASMI's admin password.
f. Enter a new HMC access password twice and click Continue.
g. From the HMC Server Management window, select Update the managed system password.
h. Enter the new password that was set in step 2f. This ends the procedure.
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3. If the problem is not resolved, contact your next level of support or your hardware service provider.

Correcting a connection problem between the HMC and a managed
system
Learn how to correct a connection problem between the Hardware Management Console (HMC) and a
managed system.

Use this procedure in the following situations:
v You have a new HMC
v You have a new system
v You are using a different HMC to manage your system.

If your system was previously connected to the same HMC and is now in No connection state, see
“Correcting a No connection state for a managed system” on page 38.
1. Choose from the following options:
v If the system uses DHCP addressing, go to step 2.
v If the system uses static addressing, go to step 6.

Note: To find out if your system uses DHCP or static addressing, perform one of the following:
v Use the ASMI by selecting Network Services > Network Configuration and viewing whether the

IP address field shows Static or Dynamic.
v If you have a control panel, use function 30.

2. If your system uses DHCP addressing, add a system automatically by issuing the following
command: mksysconn -o auto.
Is the system displayed?
v Yes: This ends the procedure.

v No: Continue with step 3.
3. Check for network problems, cables, switches, link lights on the service processor, and so on.

Was there a problem?
v Yes: Correct the problem and return to step 2.
v No: Continue with step 4.

4. Connect to ASMI and reset the network configuration to force the service processor to request a new
IP address. For more information about how to connect to ASMI and reset the network configuration,
see Configuring network interfaces.

5. Did the network configuration reset resolve the problem?
v Yes: This ends the procedure.

v No: Contact your next level of support.
6. If your system uses static IP addressing, add a system manually. Choose one of the following

navigation options depending on the interface type of the HMC:
v If you are using an HMC Classic or HMC Enhanced interface, complete the following steps:

a. In the navigation area, click Systems Management > Servers.
b. In the content pane, select the required managed system.
c. Click Tasks > Connections > Add Managed System.
d. Enter the IP address/Hostname and password, and then click OK.

v If you are using an HMC Enhanced+ interface, complete the following steps:
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a. In the navigation area, click the Resources icon , and then click All Systems.
b. In the upper left of the content pane, click Connect Systems.
c. Enter the IP address/Hostname and password, and then click OK.

Is the system displayed under system management?
v Yes: This ends the procedure.

v No: Contact your next level of support.

Correcting a version mismatch state in a managed system
Learn how to correct a version mismatch problem in a managed system.

The version mismatch problem might occur in the following situations:

The service processor firmware and Hardware Management Console (HMC) versions are
incompatible.

Use the reference code and update to the compatible service processor and HMC configurations.

An HMC Version 7.7.8, or later is connected to a server that is managed by a newer version of HMC.
If an HMC Version 7.7.8, or later is used to manage a server with a newer configuration, it might
display a new connection error state Version Mismatch with the reference code as Save Area
Version Mismatch. If you want to continue to use the lower version of HMC, initialize the
managed system in the lower version of HMC and then run any operations.

For more information, see Correcting a Version mismatch state for a managed system.

Creating a virtual drive on a 7042-CR7 installed with a single drive
Learn how to create a virtual drive on a 7042-CR7 installed with a single drive.

To create a virtual drive on a 7042-CR7 installed with a single drive, complete the following steps:
1. Power on or restart the system.
2. When the system prompt is displayed, press the F1 key to access Setup Utility.
3. In the System Configuration and Boot Management window, use the up or down arrow keys to

highlight System Settings and then press Enter.
4. In the System Settings window, use the up or down arrow keys to highlight Storage and then press

Enter.
5. In the Storage window, use the up or down arrow keys to highlight LSI MegaRAID Configuration

Utility and then press Enter.
6. In the Configuration Options window, use the up or down arrow keys to highlight Virtual Drive

Management and then press Enter.
7. In the Virtual Drive Management window, use the up or down arrow keys to highlight Create

Configuration and then press Enter.
8. In the Create Configuration window, use the up or down arrow keys to highlight Select Drives and

then press Enter.
9. In the Select Drives window, use the up or down arrow keys to highlight Check All and then press

Enter.
10. Use the up or down arrow keys to highlight Apply Changes and then press Enter.

The Success window is displayed with OK highlighted.
11. Press Enter.
12. In the Create Configuration window, use the up or down arrow keys to highlight Save

Configuration and then press Enter.
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13. In the Warning window, use the up or down arrow keys to highlight Confirm and then press Enter.
14. Use the up or down arrow keys to highlight Yes and then press Enter. The Success window is

displayed with OK highlighted.
15. Press Enter.

The Create Configuration window displays additional information.
16. Press Esc to exit the Create Configuration window.
17. Press Esc twice to go to the Configuration Options window.
18. In the Configuration Options window, use the up or down arrow keys to highlight Virtual Drive

Management and then press Enter.
19. In the Virtual Drive Management window, use the up or down arrow keys to highlight Select

Virtual Drive Operation and then press Enter.
20. In the Select Virtual Drive Operations window, use the up or down arrow keys to highlight Start

Operation and then press Enter.
21. In the Warning window, use the up or down arrow keys to highlight Confirm and then press Enter.
22. Use the up or down arrow keys to highlight Yes and then press Enter.

The Success window is displayed with OK highlighted.
23. Press Enter.
24. Press Esc until the exit Setup Utility prompt is displayed.
25. Press Y to save the changes and exit the Setup Utility. This step ends the procedure.

Creating a virtual drive on a 7042-CR9
Learn how to create a virtual drive on a 7042-CR9.

To create a virtual drive on a 7042-CR9, complete the following steps:
1. Power on or restart the system.
2. When the system prompt is displayed, press the F1 key to access Setup Utility.
3. In the System Configuration and Boot Management window, use the up or down arrow keys to

highlight System Settings and then press Enter.
4. In the System Settings window, use the Up Arrow Key or Down Arrow Key to select Storage and

then press Enter.
5. In the Storage window, use the Up Arrow Key or Down Arrow Key to select AVAGO MegaRAID

<ServeRAID M5210> Configuration Utility and then press Enter.
6. In the Dashboard View window, use the Up Arrow Key or Down Arrow Key to select Main Menu

and then press Enter.
7. In the Main menu window, use the Up Arrow Key or Down Arrow Key to select Configuration

Management and then press Enter.
8. In the Configuration Management window, use the Up Arrow Key or Down Arrow Key to

select Create Virtual Drive and then press Enter.
9. In the Create Virtual Drive window, use the Up Arrow Key or Down Arrow Key to select Genereic

RAID 1 and then press Enter.
10. In the Generic R1 window, use the Up Arrow Key or Down Arrow Key to select Save Configuration

and then press Enter.
11. In the Warning window, use the Up Arrow Key or Down Arrow Key to navigate to Confirm, then

use the space bar to highlight Yes, and press Enter.
The Success window is displayed with OK highlighted.

12. Press Enter.
13. Press Esc until the Main Menu window is displayed.
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14. In the Main Menu window, use the Up Arrow Key or Down Arrow Key to select Virtual Drive
Management and then press Enter.

15. In the Virtual Drive Management window, use the Up Arrow Key or Down Arrow Key to select
Virtual Drive 0 and then press Enter.

16. In the Virtual Drive 0 window, use the Up Arrow Key or Down Arrow Key to select View
Associated Drives and then press Enter.

17. If you have a 7042-CR9 system on which one drive is installed, ensure that the drive is displayed. If
you have a 7042-CR9 system on which two drives are installed, ensure that both drives are
displayed.

18. Press Esc until the exit Setup Utility prompt is displayed.
19. Press Y to save the changes and exit the Setup Utility. This step ends the procedure.

Resetting the managed system connection from the HMC
Use this procedure to reset the managed system connection from the Hardware Management Console
(HMC).

To reset the managed system connection, choose one of the following navigation options depending on
the interface type of the HMC:
v If you are using an HMC Classic or HMC Enhanced interface, complete the following steps:

1. In the navigation pane, select Systems Management > Servers.
2. In the contents area, select the managed system for which you want to reset the connection.
3. Select Tasks > Connections > Reset or Remove Connection.
4. Select Reset Connection.
5. Click OK.

v If you are using an HMC Enhanced + Tech Preview (Pre-GA) interface, complete the following steps:

1. In the navigation pane, click the Resources icon , and then select All Systems.
2. In the content area, select the managed system for which you want to reset the connection.
3. Select Actions > Reset or Remove Connection.
4. Select Reset Connection.
5. Click OK.

Resetting the service processor
Use this procedure to reset the service processor.

Note: Use this procedure only under the direction of your next level of support or your hardware service
provider. During this procedure, you will be powering off the system, removing ac power and reapplying
ac power.
1. Inform anyone using the server that it will be shut down.
2. Stop all applications that are running on the server.
3. Stop the operating system and server by choosing from the following options:
v If you have an HMC, shut down all logical partitions and the server. For instructions, see “HMC

and system power-on and power-off procedures” on page 47. Then continue with step 5.
v If you do not have an HMC, continue with the next step.

4. Stop the system. For instructions, see Stopping a system that is not managed by an HMC.
5. Unplug the ac power cord and then plug it back in.
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6. Start the server. For instruction, see Starting a system that is not managed by an HMC. The service
processor is reset. This ends the procedure.

HMC and system power-on and power-off procedures
Use one or more of the following procedures to power on or power off your Hardware Management
Console (HMC) or system.

Power on the HMC

During the process of powering on, the HMC checks to see which managed systems are available and
communicating with the console. To ensure that each managed system is available before you power on
the HMC, managed systems must be in standby mode or actively operating. Standby mode is indicated
by the OK shown in the operator panel after the managed system has the power connected and the initial
tests are complete.

Note: If the managed system is in an emergency power off (EPOW) condition, you must power off the
managed system before you use the HMC to power on the system.

To power on the HMC, do the following:
1. Press the Power button once to turn on the power.
2. When the system has finished the power-on self-test (POST), log in to the HMC.

Power off the HMC

To power off the HMC, choose one of the following navigation options depending on the interface type
of the HMC:
v If you are using an HMC Classic or HMC Enhanced interface, complete the following steps:

1. In the navigation area, open HMC Management.
2. In the Operations area of the contents area, select Shut Down or Restart. The Shutdown or Restart

window opens.
3. Select Shutdown HMC, and then click OK.

v If you are using an HMC Enhanced+ interface, complete the following steps:

1. In the navigation area, click the HMC Management icon , and then click Console
Management.

2. In the Management area of the content pane, click Shut Down or Restart the Management
Console.

3. Click Shutdown HMC, and then click OK.

Power-on self-test

After power is turned on and before the operating system is loaded, the system does a power-on self-test
(POST). This test performs checks to ensure that the hardware is functioning correctly before the
operating system is loaded. During the POST, codes indicating the progress of the POST might be
displayed. After the POST is complete, the HMC operating machine code loads and a login prompt is
displayed.

Power on a system by using an HMC

To power on a managed system, choose one of the following navigation options depending on the
interface type of the HMC:
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v If you are using an HMC Classic or HMC Enhanced interface, complete the following steps:
1. In the navigation area, click Systems Management > Servers.
2. In the content pane, select the required managed system.
3. Click Tasks > Operations > Power On.
4. Follow any additional on-screen instructions.

v If you are using an HMC Enhanced+ interface, complete the following steps:

1. In the navigation area, click the Resources icon , and then click All Systems.
2. In the content pane, select the required managed system name.
3. In the navigation area, click System Actions > Operations > Power On.
4. Follow any additional on-screen instructions.

Power off a system by using an HMC

Attention: If possible, shut down the running logical partitions on the managed system before powering
off the managed system. Powering off the managed system without shutting down the logical partitions
first causes the logical partitions to shut down abnormally and can cause data loss.

To power off a managed system, choose one of the following navigation options depending on the
interface type of the HMC:
v If you are using an HMC Classic or HMC Enhanced interface, complete the following steps:

1. From the navigation area, click Systems Management > Servers.
2. From the content pane, select the required managed system.
3. Click Tasks > Operations > Power Off.
4. Follow any additional on-screen instructions.

After the managed system has completed its power off sequence, you can remove the power cords if
needed. For information about how to remove the power cords, see “Remove the power cords.”

v If you are using an HMC Enhanced+ interface, complete the following steps:

1. In the navigation area, click the Resources icon , and then click All Systems.
2. In the content pane, select the required managed system name.
3. In the navigation area, click System Actions > Operations > Power Off.
4. Follow any additional on-screen instructions.

After the managed system has completed its power off sequence, you can remove the power cords if
needed. For information about how to remove the power cords, see “Remove the power cords.”

Install the power cords

Before powering on a system, ensure that the power cords have been plugged in to all of the power
supplies on all of the processor enclosures.

Remove the power cords

The system might be equipped with a second power supply. Before continuing with this procedure,
ensure that all power sources to the system have been completely disconnected.
1. Unplug any power cables that are attached to the unit from electrical outlets.
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2. Remove all power cords from all of the processor enclosures starting with the primary processor
enclosure (topmost) and then each secondary enclosure working from top to bottom.

Reinstalling the HMC machine code
Learn how to reinstall the interface and HMC machine code prior to restoring critical backup data.

If the HMC is not responding, you can install Hardware Management Console (HMC) version 8 by using
recovery media or over a network. See Upgrading or restoring HMC Version 8.

After you reinstall the HMC machine code, you can restore the backup data that you created to recover
your critical console information. For information about how to restore the HMC backup data, see
“Restoring critical HMC data.”

Backing up partition profiles
Refer to this procedure when needing to back up a partition profile.

You can back up partition profile data for a managed system only when the managed system is powered
on.

To back up partition profile data, you must be a member of one of the following roles:
v Super administrator
v Service representative

To back up partition profile data, choose one of the following navigation options depending on the
interface type of the Hardware Management Console (HMC):
v If you are using an HMC Classic or HMC Enhanced interface, complete the following steps:

1. From the navigation area, click Systems Management > Servers.
2. From the content pane, select the required managed system.
3. Click Tasks > Configuration > Manage Partition Data > Backup.
4. Enter the required backup profile name, and then click OK.

v If you are using an HMC Enhanced+ interface, complete the following steps:

1. In the navigation area, click the Resources icon , and then click All Systems.
2. In the content pane, select the system name that contains the partition, and then select the partition.
3. In the navigation area, click System Actions > Legacy > Backup.
4. Enter the required backup profile name, and then click OK.

Restoring critical HMC data
Restore critical HMC data.

Restore HMC backup data only in conjunction with a reinstallation of the HMC. For information about
how to reinstall the HMC, see “Reinstalling the HMC machine code.”

Attention: Data that is backed up by using the Save Upgrade Data or Backup Critical Console Data
tasks can be restored only to the same HMC. For information about how to replace an HMC with another
HMC, see “Replacing an HMC” on page 67.

Note: For this operation, you must have one of the following:
v The backup DVD media
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v Access to the remote server where the archive was created by using the procedure in “Backing up
critical HMC data” on page 69

To restore the HMC data, you must be a member of one of the following roles:
v Super administrator
v Operator
v Service representative

Select the data-restoration procedure based on the data archiving method used:

If the critical console data has been archived on a DVD, complete the following steps:
1. Select 1 - Restore Critical Console Data from the menu displayed at the end of the HMC

reinstallation.
2. Insert the DVD containing the archived console data. On the first boot of the newly installed HMC,

the data is automatically restored.

If the critical console data has been archived on a remote repository, choose one of the following options:
v If you are using the HMC Classic or HMC Enhanced interface, see Restore HMC Data.
v If you are using the HMC Enhanced+ interface, see Restore Management Console Data.

This ends the procedure.

Rebuilding a RAID 1 array
Use this information to rebuild a RAID 1 array on a Hardware Management Console (HMC) that has a
failed disk drive or solid-state drive.

Before you begin, ensure that you replace the failed disk drive or solid-state drive. For instructions about
replacing a drive, see the Problem determination and service guide for your HMC model.

To rebuild a RAID 1 array on the HMC, complete the following steps:

Note: If your system is an 7042-CR9, see “Rebuilding a RAID 1 array after a drive failed on a 7042-CR9”
on page 51.
1. Power on or restart the system.
2. When the system prompt is displayed, press the F1 key to access the Setup utility.
3. In the System Configuration and Boot Management window, use the up arrow key or the down

arrow key to select System Settings and then press Enter.
4. In the System Settings window, use the up arrow key or the down arrow key to select Storage and

then press Enter.
5. In the Storage window, use the up arrow key or the down arrow key to select LSI MegaRAID

<ServeRAID M5210> Configuration Utility and then press Enter.
6. In the Dashboard View window of the LSI MegaRAID <ServeRAID M5210> Configuration utility,

does the status have a value of <Optimal>?
v Yes: The array does not need to be rebuilt. This ends the procedure

v No: Continue with next step.
7. In the Dashboard View window of the LSI MegaRAID <ServeRAID M5210> Configuration utility,

use the up arrow key or the down arrow key to select Main Menu and then press Enter.
8. In the Main Menu window, use the up arrow key or the down arrow key to select Drive

Management and then press Enter.
9. In the Drive Management window, is the drive listed as rebuilding?
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v Yes: The array is rebuilding. You can now exit the utility and allow the HMC to boot normally.
The rebuild operation will continue until the entire array is rebuilt. This ends the procedure.

v No: Continue with the next step.
10. In the Drive Management window, use the up arrow key or the down arrow key to select the drive

that is listed as Unconfigured Bad and then press Enter.
11. In the Unconfigured Bad window, use the up arrow key or the down arrow key to select <Select

operation> and then press Enter.
12. From the Select operation menu, select Make Unconfigured Good and then press Enter. Use the up

arrow key or the down arrow key to select Go and then press Enter.
13. A window is displayed with the message "The operation has been performed successfully." Press

Enter.
14. Exit to the Main Menu window. In the Main Menu window, use the up arrow key or the down

arrow key to select Drive Management and then press Enter.
15. In the Drive Management window, is the drive listed as (Foreign) Unconfigured Good?

v Yes: The drive must be initialized. Continue with the next step.
v No: The drive is listed as Unconfigured Good and does not need to be initialized. Continue with

step 20.
16. In the Drive Management window, use the up arrow key or the down arrow key to select the drive

that is listed as (Foreign) Unconfigured Good and then press Enter.
17. In the (Foreign) Unconfigured Good window, use the up arrow key or the down arrow key to select

<Select operation> and then press Enter.
18. From the Select operation menu, select Initialize Drive and then press Enter. Use the up arrow key

or the down arrow key to select Go and then press Enter.
19. In the Warning screen, select Confirm and press the space bar. Select Yes and then press Enter.

Continue with the next step after the initialization of the drive is complete.

Note: The Initialize Drive operation can take up to an hour to complete.
20. In the Drive Management window, use the up arrow key or the down arrow key to select the drive

that is listed as Unconfigured Good and then press Enter.
21. In the Unconfigured Good window, use the up arrow key or the down arrow key to select <Select

operation> and then press Enter.
22. From the Select operation menu, select Assign Global Hot Spare Drive and then press Enter.
23. In the Unconfigured Good window, use the up arrow key or the down arrow key to select Go and

then press Enter.
24. In the Warning screen, select Confirm and press the space bar. Select Yes and then press Enter.
25. In the Unconfigured Good window, ensure that the progress field has a value of Rebuild x%, where x

indicates percent complete. The rebuild operation has started. You can now exit the utility and allow
the HMC to boot normally. The rebuild operation will continue until the entire array is rebuilt. This
ends the procedure.

Rebuilding a RAID 1 array after a drive failed on a 7042-CR9
Use this information to rebuild a RAID 1 array on a 7042-CR9 that has a failed disk drive or solid-state
drive.

Before you begin, ensure that you replace the failed disk drive or solid-state drive. For instructions about
replacing a drive, see the Problem determination and service guide for your HMC model.

To rebuild a RAID 1 array on the 7042-CR9, complete the following steps:
1. Power on or restart the system.
2. When the system prompt is displayed, press the F1 key to access the Setup utility.
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3. In the System Configuration and Boot Management window, use the up arrow key or the down
arrow key to select System Settings and then press Enter.

4. In the System Settings window, use the up arrow key or the down arrow key to select Storage and
then press Enter.

5. In the Storage window, use the up arrow key or the down arrow key to select LSI MegaRAID
<ServeRAID M5210> Configuration Utility and then press Enter.

6. In the Dashboard View window of the LSI MegaRAID > ServeRAID M5210 > Configuration
Utility utility, does the status have a value of <Optimal>?
v Yes: The array does not need to be rebuilt. This ends the procedure

v No: Continue with next step.
7. In the Dashboard View window of the LSI MegaRAID <ServeRAID M5210> Configuration utility,

use the up arrow key or the down arrow key to select Main Menu and then press Enter.
8. In the Main Menu window, use the up arrow key or the down arrow key to select Drive

Management and then press Enter.
9. In the Drive Management window, is the drive listed as rebuilding?
v Yes: The array is rebuilding. You can now exit the utility and allow the HMC to boot normally.

The rebuild operation will continue until the entire array is rebuilt. This ends the procedure.
v No: Continue with the next step.

10. In the Drive Management window, use the up arrow key or the down arrow key to select the drive
that is listed as Unconfigured Bad and then press Enter.

11. In the Unconfigured Bad window, use the up arrow key or the down arrow key to select <Select
operation> and then press Enter.

12. From the Select operation menu, select Make Unconfigured Good and then press Enter. Use the up
arrow key or the down arrow key to select Go and then press Enter.

13. A window is displayed with the message The operation has been performed successfully. Press
Enter.

14. Exit to the Main Menu window. In the Main Menu window, use the up arrow key or the down
arrow key to select Drive Management and then press Enter.

15. In the Drive Management window, is the drive listed as (Foreign) Unconfigured Good?
v Yes: The drive must be initialized. Continue with the next step.
v No: The drive is listed as Unconfigured Good and does not need to be initialized. Continue with

step 21.
16. In the Drive Management window, use the up arrow key or the down arrow key to select the drive

that is listed as (Foreign) Unconfigured Good and then press Enter.
17. In the (Foreign) Unconfigured Good window, use the up arrow key or the down arrow key to select

<Select operation> and then press Enter.
18. From the Select operation menu, select Initialize Drive and then press Enter.
19. In the confirmation window, use the up arrow key or the down arrow key to select Go and then

press Enter.
20. In the Warning screen, select Confirm and press the space bar. Select Yes and then press Enter.

Continue with the next step after the initialization of the drive is complete.

Note: The Initialize Drive operation can take up to an hour to complete.
21. In the Drive Management window, use the up arrow key or the down arrow key to select the drive

that is listed as Unconfigured Good and then press Enter.
22. In the Unconfigured Good window, use the up arrow key or the down arrow key to select <Select

operation> and then press Enter.
23. From the Select operation menu, select Assign Global Hot Spare Drive and then press Enter.
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24. In the Unconfigured Good window, use the up arrow key or the down arrow key to select Go and
then press Enter.

25. In the Warning screen, select Confirm and press the space bar. Select Yes and then press Enter.
26. In the Unconfigured Good window, ensure that the progress field has a value of Rebuild x%, where x

indicates percent complete. The rebuild operation has started. You can now exit the utility and allow
the HMC to boot normally. The rebuild operation will continue until the entire array is rebuilt. This
ends the procedure.

Deleting a virtual drive on a 7042-CR9
Learn how to delete a virtual drive on a 7042-CR9 installed with a single drive.

To delete a virtual drive on a 7042-CR9 installed with a single drive, complete the following steps:

Note: Deleting the virtual drive on the HMC destroys all of the data stored on the drive. Perform this
procedure only if you have a backup of the data on that drive, or if you have been instructed to do so by
IBM support.
1. Power on or restart the system.
2. When the system prompt is displayed, press the F1 key to access Setup Utility.
3. In the System Configuration and Boot Management window, use the up or down arrow keys to

highlight System Settings and then press Enter.
4. In the System Settings window, use the up or down arrow keys to highlight Storage and then press

Enter.
5. In the Storage window, use the up or down arrow keys to highlight LSI MegaRAID <ServeRAID

M5210> Configuration Utility and then press Enter.
6. In the Main menu window, use the up or down arrow keys to highlight Virtual Drive Management

and then press Enter.
7. In the Virtual Drive Management window, use the up or down arrow keys to highlight Virtual

Drive 0: and then press Enter.
8. In the Virtual Drive 0: window, use the up or down arrow keys to highlight <Select operation> and

then press Enter.
9. From the Select operation menu, select Delete Virtual Drive and then press Enter. Use the up arrow

key or the down arrow key to select Go and then press Enter.
10. In the Warning window, use the up or down arrow keys to navigate to Confirm, then use the space

bar to highlight Yes, and press Enter.
The Success window is displayed with OK highlighted.

11. Press Enter.
After the drive is deleted, the following message is displayed: Unable to display Virtual Drive
summary as there are no Virtual Drives currently available.

12. Press Esc. This step ends the procedure.

Upgrading the machine code on an HMC
Learn how to upgrade the machine code on an HMC while maintaining your HMC configuration data.

Perform Steps 1 through 9 to upgrade machine code on an HMC.

Important: You must be at a minimum of HMC machine code Version 6 Release 1.2 to upgrade to
Version 7 Release 3.1.0.

Step 1. Obtain the upgrade
You can order the HMC machine code upgrade through the Fix Central website, by contacting service
and support, or by downloading it to an FTP server.
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Note: If you do not have access to the Internet, contact service and support to order the upgrade on
DVD.
1. From a computer or server with an Internet connection, go to the Fix Central website Fix Central.
2. Select the appropriate family in the Product family list.
3. Select Hardware Management Console in the Product or fix type list.
4. Click Continue. The Hardware Management Console website is displayed.
5. Navigate to the HMC version that you want.
6. Locate the Recovery CD download and ordering section.
7. Follow the on-screen prompts to submit your order.
8. After you receive the upgrade, continue with “Step 2. Back up critical HMC data.”

Step 2. Back up critical HMC data
Back up critical HMC data before installing a new version of HMC software so that previous levels can
be restored in the event of a problem while upgrading the software. Do not use this critical HMC data
after a successful upgrade to a new version of the HMC software.
1. Complete the steps in “Backing up critical HMC data” on page 69.
2. Continue with “Step 3. Record the current HMC configuration information.”

Step 3. Record the current HMC configuration information
Before you upgrade to a new version of HMC software, as a precautionary measure, record HMC
configuration information.

To record HMC configuration information, choose one of the following navigation options depending on
the interface type of the HMC:
v If you are using an HMC Classic or HMC Enhanced interface, complete the following steps:

1. In the navigation area, click HMC Management.
2. In the tasks list, under the Operations section, click Schedule Operations.
3. Select the HMC you plan to upgrade and click OK. All scheduled operations for the HMC are

displayed.
4. Click Sort > By Object.
5. Select each object and record the following details:

– Object Name
– Schedule date
– Operation Time (displayed in 24-hour format)
– Repetitive (if Yes, perform the following steps:)

a. Click View > Schedule Details.
b. Record the interval information.
c. Close the scheduled operations window.
d. Repeat for each scheduled operation.

6. Close the Customize Scheduled Operations window.
7. Continue with “Step 4. Record remote command status” on page 55.

v If you are using an HMC Enhanced+ interface, complete the following steps:

1. In the navigation area, click the Resources icon , and then click All Systems.
2. To view the actions for the server, select the server name of the server in the content pane.
3. In the navigation area, click System Actions > Operations > Schedule Operations. All scheduled

operations for the HMC are displayed.
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4. Click Sort > By Object.
5. Select each object and record the following details:

– Object Name
– Schedule date
– Operation Time (displayed in 24-hour format)
– Repetitive (if Yes, perform the following steps:)

a. Click View > Schedule Details.
b. Record the interval information.
c. Close the scheduled operations window.
d. Repeat for each scheduled operation.

Step 4. Record remote command status
Choose one of the following navigation options depending on the interface type of the HMC:
v If you are using an HMC Classic or HMC Enhanced interface, complete the following steps:

1. In the navigation area, click HMC Management.
2. In the Administration area of the content pane, click Remote Command Execution.
3. Record whether the Enable remote command execution using the ssh facility check box is

selected.
4. Click Cancel.
5. Continue with “Step 5. Save upgrade data.”

v If you are using an HMC Enhanced+ interface, complete the following steps:

1. In the navigation area, click the Users and Security icon , and then click Systems and
Console Security.

2. In the Remote Control area of the content pane, click Enable/Disable Remote Command
Execution.

3. Record whether the Enable remote command execution using the ssh facility check box is
selected.

4. Click Cancel.
5. Continue with “Step 5. Save upgrade data.”

Step 5. Save upgrade data
You can save the current HMC configuration on either a locally mounted USB flash memory drive or a
designated disk partition on the HMC. Save upgrade data immediately before upgrading your HMC
software to a new release. Use this action to restore HMC configuration settings after you upgrade the
HMC.

Note: Only one level of backup data is allowed on the selected media. Each time that you save upgrade
data, the previous level of data is overwritten.

Choose one of the following navigation options. The option that you choose depends on the interface
type of the HMC:
v If you are using an HMC Classic or HMC Enhanced interface, complete the following steps:

1. In the navigation area, click HMC Management.
2. In the content pane, under the Operations section, click Save Upgrade Data. The Save Upgrade

Data Wizard window is displayed.
3. From the Media list, click Hard drive and then click Next.
4. Click Finish.
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5. Wait for the task to complete. If the Save Upgrade Data task fails, contact your next level of
support before proceeding.

Note: If the Save Upgrade Data task fails, do not continue the upgrade process.
6. Click OK.
7. Continue with “Step 6. Upgrade the HMC software.”

v If you are using an HMC Enhanced+ interface, complete the following steps:

1. In the navigation area, click the HMC Management icon , and then click Console
Management.

2. In the Maintenance and Data area of the content pane, click Save Upgrade Data. The Save
Upgrade Data Wizard window is displayed.

3. From the Media list, click Hard drive and then click Next.
4. Click Finish.
5. Wait for the task to complete. If the Save Upgrade Data task fails, contact your next level of

support before proceeding.

Note: If the Save Upgrade Data task fails, do not continue the upgrade process.
6. Click OK.
7. Continue with “Step 6. Upgrade the HMC software.”

Step 6. Upgrade the HMC software
To upgrade the HMC software, do the following:
1. Insert the HMC Product Installation DVD-RAM into the DVD-RAM drive.
2. Select Upgrade and click Next.
3. When the message is displayed, choose from the following options:
v If you have saved upgrade data during the previous task, continue with the next step.
v If you did not save upgrade data previously in this procedure, you must save the upgrade data

now before you continue.
4. Select Upgrade from media and click Next.
5. Confirm the settings and click Finish.
6. Follow the on-screen prompts.

Notes:

v If the screen goes blank, press the space bar to view the information.
v The first DVD can take approximately 20 minutes to install.

7. When prompted, remove the first media and then insert the second media into the DVD-RAM drive.
8. Select 1. Install additional software from media and press Enter. Press any key to confirm the

installation. The HMC will display status messages while it installs the packages.
9. When the second media installation is complete, remove the media from the drive and close the

drawer.
10. Select Option 2 Finish the installation and press Enter. The HMC will complete the booting process.
11. Accept the License Agreement for Machine Code twice.
12. At the login prompt, log in using your user ID and password. The HMC code installation is

complete.
13. Continue with “Step 7. Verify that the HMC machine code upgrade installed successfully” on page

57.
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Step 7. Verify that the HMC machine code upgrade installed successfully
1. Verify that the version and release match the update that you installed.
2. If the level of code displayed is not the level that you installed, perform the following steps:

a. Try again to update the HMC machine code by using a different DVD.
b. If the problem persists, contact your next level of support.

HMC problem analysis
Use this information to diagnose and repair problems that are related to the Hardware Management
Console (HMC).

DANGER: When working on or around the system, observe the following precautions:

Electrical voltage and current from power, telephone, and communication cables are hazardous. To avoid
a shock hazard:
v If IBM supplied the power cord(s), connect power to this unit only with the IBM provided power cord.

Do not use the IBM provided power cord for any other product.
v Do not open or service any power supply assembly.
v Do not connect or disconnect any cables or perform installation, maintenance, or reconfiguration of this

product during an electrical storm.
v The product might be equipped with multiple power cords. To remove all hazardous voltages,

disconnect all power cords.
– For AC power, disconnect all power cords from their AC power source.
– For racks with a DC power distribution panel (PDP), disconnect the customer’s DC power source to

the PDP.
v When connecting power to the product ensure all power cables are properly connected.

– For racks with AC power, connect all power cords to a properly wired and grounded electrical
outlet. Ensure that the outlet supplies proper voltage and phase rotation according to the system
rating plate.

– For racks with a DC power distribution panel (PDP), connect the customer’s DC power source to
the PDP. Ensure that the proper polarity is used when attaching the DC power and DC power
return wiring.

v Connect any equipment that will be attached to this product to properly wired outlets.
v When possible, use one hand only to connect or disconnect signal cables.
v Never turn on any equipment when there is evidence of fire, water, or structural damage.
v Do not attempt to switch on power to the machine until all possible unsafe conditions are corrected.
v Assume that an electrical safety hazard is present. Perform all continuity, grounding, and power checks

specified during the subsystem installation procedures to ensure that the machine meets safety
requirements.

v Do not continue with the inspection if any unsafe conditions are present.
v Before you open the device covers, unless instructed otherwise in the installation and configuration

procedures: Disconnect the attached AC power cords, turn off the applicable circuit breakers located in
the rack power distribution panel (PDP), and disconnect any telecommunications systems, networks,
and modems.

DANGER:
v Connect and disconnect cables as described in the following procedures when installing, moving, or

opening covers on this product or attached devices.
To Disconnect:
1. Turn off everything (unless instructed otherwise).
2. For AC power, remove the power cords from the outlets.
3. For racks with a DC power distribution panel (PDP), turn off the circuit breakers located in the

PDP and remove the power from the Customer's DC power source.
4. Remove the signal cables from the connectors.
5. Remove all cables from the devices.
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To Connect:
1. Turn off everything (unless instructed otherwise).
2. Attach all cables to the devices.
3. Attach the signal cables to the connectors.
4. For AC power, attach the power cords to the outlets.
5. For racks with a DC power distribution panel (PDP), restore the power from the Customer's DC

power source and turn on the circuit breakers located in the PDP.
6. Turn on the devices.

Sharp edges, corners and joints may be present in and around the system. Use care when handling
equipment to avoid cuts, scrapes and pinching. (D005)

If you were directed here from the Beginning problem analysis procedure because your HMC is not
functioning correctly, continue with the “Entry point for HMC problem determination.”

To perform other maintenance tasks on your HMC, see following procedures:
v For general maintenance information on the base server that is used to build the HMC, see “HMC

diagnostics” on page 8.
v For instructions to replace an HMC, see Replacing an HMC.
v For HMC parts information, see following:

– Hardware Management Console (HMC) parts. Because the server that is used for your HMC can be
serviced by the customer, you are the service provider for your HMC.

– To find links to the appropriate server hardware maintenance information, see “Equivalent
maintenance information for the HMC server hardware” on page 9.

v For removing and replacing HMC parts, see “Removal and replacement procedures” on page 6.
v For backing up critical disk drive information on the HMC, see Backing up critical HMC data topic.
v For restoring disk drive information on the HMC, see Reinstalling the HMC machine code .
v For checking modem settings, see Cabling the HMC topic.

Entry point for HMC problem determination
Find the symptom you are having in the Symptom column of the following table. Then perform the
action described in the Action column.

Symptom Action

Operator reported that the HMC did
not start, but no other problems were
reported.

Go to “Beginning HMC problem determination” on page 59.

Operator reported Communication
not active on the HMC.

Go to “Testing the HMC Ethernet adapter” on page 63.

Operator reported communication
problems with a remotely connected
HMC or a managed system.

Go to “Testing the modem connection to the managed system” on page 61.

Power problems Go to “Testing for a power problem” on page 60.

HMC boot problems Go to “Beginning HMC problem determination” on page 59.

Display problem Go to “Testing the HMC display” on page 66.

DVD-RAM drive problem Go to “Testing the HMC DVD-RAM drive” on page 64.

Diskette drive problem Go to “Testing the HMC diskette drive” on page 66.

Ethernet LAN problem Go to “Testing the HMC Ethernet adapter” on page 63.
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Symptom Action

A problem with any of the following:

v display

v diskette drive

v DVD-RAM Drive

v disk drive

v Ethernet LAN

Perform Dynamic System Analysis. For more information about Dynamic
System Analysis, see Diagnostic tools.

Eight character error code beginning
with HMC was received when using
the HMC graphical user interface.

Go to the “HMC system reference code” on page 8.

HMC does not communicate through
the modem.

Go to “Testing the HMC modem connection” on page 61.

Problems understanding the usage of
the HMC.

Go to Managing the Hardware Management Console.

All other problems (for example:
HMC GUI is unresponsive, parity
errors, power, POST codes, blank
display, mouse, or keyboard).

Go to “Beginning HMC problem determination.”

Symptoms not in this list. Go to “Beginning HMC problem determination.”

Beginning HMC problem determination
Use this procedure to determine if there is a problem with the HMC hardware. This procedure might
direct you to procedures in various sections of this information or to server maintenance information.

Step 1. HMC problem determination:

1. If the HMC is running, shut down the console by exiting the graphical user interface. The server
power turns off automatically. If the server cannot turn off the power, then turn the power switch off.

2. Turn on the HMC power.
3. Watch the console and allow enough time for the system to complete the POST and load the HMC

machine code.
4. Watch and listen for the following failing symptoms during power-on:
v POST error condition.
v A series of beeps that indicate an error condition.
v The HMC login screen and user interface fails to start.
v A reference code or any other error information is displayed.

5. Do you have any of the failing symptoms during power on?
v No: Continue with step “Step 2. HMC problem determination.”
v Yes: Go to the “Equivalent maintenance information for the HMC server hardware” on page 9.

Step 2. HMC problem determination:

1. Perform Dynamic System Analysis. For more information about Dynamic System Analysis, see
Diagnostic tools.

2. Did the system unit tests detect errors?
v No: Go to “Step 3. HMC problem determination” on page 60.
v Yes: Continue with step “Step 3. HMC problem determination” on page 60.

3. Use the Dynamic System Analysis and the maintenance procedures for the type of server that you are
working on to isolate the failure and exchange customer replaceable units (CRUs). Refer to the
publications listed in the “Equivalent maintenance information for the HMC server hardware” on
page 9.
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4. When the problem is repaired, or if the problem cannot be isolated, continue with “Step 4. HMC
problem determination.”

Step 3. HMC problem determination:
Attention: This step requires HMC support assistance. Contact HMC support before continuing.
1. If you are directed to reload the HMC from the recovery DVD and then reload the backup profile and

configuration data, see “Reinstalling the HMC machine code” on page 49.
2. After reloading the machine code from the recovery DVD, does the HMC start correctly?
v No: Contact your next level of support.
v Yes: This ends the procedure.

Step 4. HMC problem determination:

Note: If you reach this step and you have not been able to isolate a failure, contact your next level of
support for assistance.
1. Reinstall all CRUs that did not fix the problem.
2. You must have performed a repair action to continue. If you have not already done so, verify the

repair. Perform Dynamic System Analysis. For more information about Dynamic System Analysis, see
Diagnostic tools.

3. Did the system unit tests run without errors?
v No: Use the Dynamic System Analysis and the maintenance procedures for the type of server that

you are working on to isolate the failure and exchange customer replaceable units (CRUs). Refer to
the publications listed in the “Equivalent maintenance information for the HMC server hardware”
on page 9. Then continue with step 4.

v Yes: Continue with step 4.
4. Does the HMC communicate with all connected managed systems?
v No: Go to “Testing the modem connection to the managed system” on page 61.
v Yes: Did you exchange the system board or the system board battery?

– No: This ends the procedure.

– Yes: Recover the HMC. For details, see “Reinstalling the HMC machine code” on page 49. This
ends the procedure.

Testing the HMC

Use these procedures when you are directed to them from the HMC problem analysis procedure to test
the HMC. If a failure is detected, you will be instructed to fix the failing part and then verify the repair.

Testing for a power problem:
To troubleshoot a power problem on the server, see service documentation for the server on which your
HMC is based. For server hardware maintenance manuals to help isolate the problem to a failing part,
see publications listed in “Equivalent maintenance information for the HMC server hardware” on page 9.

Performing diagnostic procedures:
You should have been directed here to test a specific part of the HMC. For problems in the following
areas, perform Dynamic System Analysis:
v Display
v Keyboard
v Mouse
v Floppy Drive
v DVD-RAM
v DASD (disk drive)
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v Memory
v Power
v Run All Selected
v SCSI
v System Port/Modem
v 16/4 Port Serial
v Ethernet

To access the HMC diagnostic information, follow the procedures in “HMC diagnostics” on page 8.

Testing the modem connection to the managed system:
Use this procedure to test the modem connection to the server for the HMC.
1. Can the HMC be used to communicate through the modem?
v No: Go to step 2.
v Yes: This ends the procedure.

2. Is a device other than a modem attached to system port 2 on the HMC?

Note: If the HMC is a rack-mounted model, answer no to this question.
v No: Go to “Testing the HMC modem connection.”
v Yes: Go to step 3.

3. System port 2 of the HMC is reserved for external modem use only. Move the serial cable from serial
port 2 of the HMC to another HMC system port. Connect the modem to system port 2 and go to step
1.

Note: If the HMC is a rack-mounted model, an internal modem is installed to handle the connection
of the HMC to the telephone line. If a redundant telephone connection is required, connect an external
modem to the system port on the rear of the HMC. If needed, go to the MultiTech MultiModemII

installation guide for modem installation instructions. If you do not have access to a hardcopy version
of the MultiTech MultiModemII documentation, go to the MultiTech Product Support website
(www.multitech.com/support).

Testing the HMC modem connection:
Use this procedure to test the modem connection to the server for the HMC.
1. Verify that the modem and the telephone line are functioning correctly by performing the following

steps:
a. On the HMC console, open the Service Agent application.
b. Select Test Tools.
c. Initiate a Test PMR.
d. Monitor the call log to verify that the call is completed successfully. If the call is completed

successfully, the modem is functioning correctly.
2. Is the installed modem currently functioning on the HMC?
v No: Go to step 3.
v Yes: The problem is not in the modem. This ends the procedure.

3. Are the HMC configurations, relating to the modem operation, correct?
v No: Correct the HMC configuration arguments. Return to step 1.
v Yes: Continue with step 4.

4. Is the modem powered on? (Are any indicators lit?)
v No: Ensure the modem is powered on. For details, see 1. After power on verification is completed,

continue with step 5 on page 62.
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v Yes: Go to step 6.
5. Is the serial cable between the serial (COM) port connector of the HMC and the modem attached?
v No: Attach the serial cable between the serial (COM) port connector of the HMC and the modem.
v Yes: Go to step 6.

6. Is the modem connected correctly to a working telephone line or an equivalent?

Note: This can be checked by connecting a known good telephone to the line in place of the modem
and making a telephone call.
v No: Correctly connect the telephone line (or equivalent) to the modem. Go to step 1 on page 61.

After completing the telephone line and modem verification test, continue with step 7.
v Yes: Go to step 7.

7. Verify the COM port by performing the following steps:
a. Disconnect the modem cable from the COM port of the HMC.
b. Select Diagnostics from the top menu.
c. Select System Ports from the pull-down menu. The SERIAL PORT TEST CATEGORY screen

displays.
d. Ensure the following:
v On desktop HMC models - IRQ numbers 4 and 3 are assigned to COM 1 and COM 2, and the

planar to COM 2 connector cable is present and correctly installed.
v On rack-mounted models - IRQ number 4 is assigned from COM 1.

Note: If the preceding information is not correct, the COM port might be disabled, or might be
incorrectly configured. This can be resolved by accessing the setup utility (by pressing the F1 key)
during power on.

e. Ensure all diagnostics except External Loopback are selected.
f. Select Run Screen from the bottom menu.
g. Ensure all selected diagnostics show Passed.

Note: If any diagnostics fail, replace the planar.
8. Verify the external modem by performing the following steps:

a. Reconnect the modem cable to the correct COM port.
b. Ensure that the modem is powered on, connected to a working telephone line, and is securely

cabled to the communications cable.
c. Shut down and restart the HMC.
d. Select Hardware Info from the top menu.
e. Select COM and LPT Ports from the menu. The hardware query displays COM and LPT port

information.
f. Verify the following:
v A modem was detected on the correct COM port
v The modem test returned Passed
v Dial tone: Detected
v ATI1: Displays the modem's model information

Note:

a. If you were not able to get the desired results in step 8f, see MultiTech MultiModemII user's guide,
installation guide, or reference guide for your modem. To access the MultiTech MultiModemII

documentation, go to the MultiTech Product Support website (www.multitech.com/support).
b. If necessary, after you have completed the MultiTech MultiModemII documentation, return here to

complete the final step of this procedure.
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9. Choose from the following options:
v If the modem was not detected, replace and verify the following customer replaceable parts in the

order listed:
a. Communications cable
b. Modem

v If the modem test did not return with Passed, replace the modem.
v If the dial tone did not return with Detected, verify the telephone line operation then retest. If the

failure recurs, replace the modem.

Testing the HMC Ethernet adapter:
Use this procedure to test the Ethernet adapter in the HMC.
1. Is the Ethernet port currently functioning though normal operation of the HMC?
v No: Go to step 2.
v Yes: This ends the procedure.

2. Are the Ethernet configuration values set correctly? (IP address, subnet mask, and so on.)
v No: Set the Ethernet configuration values to their correct settings. Then go back to step 1.
v Yes: Go to step 3.

3. Can the IP address of the HMC be 'pinged' by another system that should be able to 'see' the HMC
on the network?
v No: Go to step 4.
v Yes: Go to step 8.

4. Is the Ethernet cable attached correctly to the HMC and the network?
v No: Attach the HMC to the network using an Ethernet cable with the correct pinout. Then go to

step 1.
v Yes: Go to step 5.

5. Is the Ethernet cable the correct pinout? (There are two types of Ethernet cables in use, which are
distinguished by different pinouts. The network will determine which version of cable to use.)
v No: Replace the Ethernet cable with the correct version. Then go to step 1.
v Yes: Go to step 6.

6. Refer to the Ethernet hardware's hardware maintenance manual to determine if there are any internal
settings or jumpers that might disable the Ethernet port.
Are there any internal settings or jumpers?
v No: Go to step 7.
v Yes: Go to step 8.

7. Replace the Ethernet hardware in the HMC. (This might be a PCI card or system board replacement,
depending on the HMC hardware.) Go to step 1.

8. Set the internal settings/jumpers to enable the Ethernet port on the HMC. Go to step 1.
The failure does not seem to be in the HMC.

Testing the HMC disk drive:

Learn how to test and run diagnostics on a failing HMC disk drive.

To test for HMC disk drive problems, complete the following steps:
1. Did the disk drive test fail?
v No: Go to step 5 on page 64.
v Yes: Continue with the next step.

2. Perform the following steps:
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a. Exchange the CRUs called by the diagnostics one at a time. For CRU removal and replacement
instructions, see server hardware maintenance manual for the system on which you are working.
See “Equivalent maintenance information for the HMC server hardware” on page 9 to access the
hardware maintenance manual for your HMC server model.

b. After each CRU is exchanged, test the repair. Perform Dynamic System Analysis on the disk drive.
For more information about Dynamic System Analysis, see Diagnostic tools.
Did the disk drive test fail?
v No: Continue with the next step.
v Yes: Contact your next level of support.

3. Ensure the following and then continue with the next step:
v If you exchanged the disk drive and there are jumpers or tab settings on the new disk drive, ensure

that the settings are the same as the old drive.
v If there is a SCSI cable-terminating resistor device, ensure it is secured to the cable and (if

necessary) reattached to its original location on the server.
Go to the information about hard disk jumper settings in the server hardware maintenance manual.
See “Equivalent maintenance information for the HMC server hardware” on page 9 to access the
hardware maintenance manual for your HMC server model.

4. If you exchanged the disk drive, restore the HMC image to the new disk drive.
5. Perform Dynamic System Analysis to test the server. For more information about Dynamic System

Analysis, see Diagnostic tools.
v If the tests fail, isolate the problem using the “Beginning HMC problem determination” on page 59

procedure.
v If the tests run without errors, turn off the server power and then turn on the power. Ensure that

the system boots and the HMC screen is displayed. This ends the procedure.

Testing the HMC DVD-RAM drive:

Learn how to test and run diagnostics on a failing DVD-RAM.

To test for HMC DVD-RAM drive problems, complete the following steps:
1. Determine the media in the DVD-RAM drive:
v Compact Disk Recordable (CD-R) similar to a CD
v DVD-RAM media cartridge
Is the media a CD-R?
v No: Go to step 4.
v Yes: Continue with the next step.

2. Perform the following steps:
a. Clean the compact disk as follows:
v Hold the disk by its edges. Do not touch the surface.
v Remove dust and fingerprints from the surface by wiping from the center to the outside using

a dry, soft cloth.
b. Reinstall the CD, with the label-side facing up.
c. Continue with the next step.

3. Try the failing task again by using the original media.
Does the failure occur again?
v No: This ends the procedure.

v Yes: Continue with the next step.
4. Ensure the write protect tab is in the "disabled" (down) position.

Was the write protect tab in the "disabled" (down) position?
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v No: Go to step 3 on page 64.
v Yes: Continue with the next step.

5. Perform the following steps:
a. With the original media in the drive, note the following:
v If you are attempting a restore procedure, turn off the server power.
v For any other operation, shut down the HMC, and then turn off the server power.

Note: For shutdown procedures, see “HMC and system power-on and power-off procedures”
on page 47.

b. Turn on the server power and perform Dynamic System Analysis to test the DVD-RAM drive.
For more information about Dynamic System Analysis, see Diagnostic tools.

c. When the test is complete, continue with the next step.
6. Did the DVD-RAM test fail while testing with the original media?
v No: Go to step 15.
v Yes: Continue with the next step.

7. Exchange the original media with a new one.

Note: If you are replacing DVD-RAM media, the new cartridge must be formatted. If possible, use
another HMC to format the new cartridge.

8. Turn off the server power.
9. Turn on the server power, and perform Dynamic System Analysis to test the DVD-RAM drive with

the new media. For more information about Dynamic System Analysis, see Diagnostic tools.
10. Did the DVD-RAM test fail while testing with the new media?

v No: The original media was defective. This ends the procedure.

v Yes: Continue with the next step.
11. Verify the following:

v All DVD-RAM drive data and power cables are secure.
v The DVD-RAM drive is jumpered as "master" and is cabled to the secondary IDE bus.

12. If the diagnostics continue to fail, exchange the DVD-RAM drive. When complete, run the
DVD-RAM test again.

Note: If there are any jumpers or tab settings on the new drive, ensure that the settings match the
old drive.

13. Did the DVD-RAM Drive test continue to fail?
v No: The original DVD-RAM drive was defective. This ends the procedure.

v Yes: Continue with the next step.
14. Continue exchanging CRU from the CRU list and running the DVD-RAM drive tests.

v If the CRUs fix the problem, this ends the procedure.
v If you cannot isolate the problem, call your next level of support for assistance.

15. The server resources (for example: interrupt, I/O address) might be configured incorrectly. Verify the
server resources are correctly configured.
a. Select System Unit for the configuration area, and verify configuration for the system unit and

all adapters.
b. When you complete the verification, try the failing procedure again and continue with the next

step.
16. Does the failing procedure continue to fail?

v No: The resource settings were incorrect. This ends the procedure.
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v Yes: If you cannot isolate the problem, contact your next level of support for assistance. This ends
the procedure.

Testing the HMC diskette drive:

Learn to run a diagnostic test to determine diskette drive problems.

To test for HMC diskette drive problems, complete the following steps:
1. Perform the following steps:

a. Turn on the server power and perform the Dynamic System Analysis to test the diskette drive.
For more information about Dynamic System Analysis, see Diagnostic tools.

Note: Do not test with the diskette on which the errors occurred. Use a new diskette.
b. When the test is complete, continue with the next step.

2. Did the diskette test fail while testing with a new diskette?
v No: Go to step 6.
v Yes: Continue with the next step.

3. Exchange the diskette drive and run the diskette test again.
4. Did the diskette test fail again?
v No: The original diskette drive was failing. This ends the procedure.

v Yes: Continue with the next step.
5. Continue exchanging CRUs from the CRU list and running tests. If one of the replaced CRUs fixes

the problem, this ends the procedure. If you cannot resolve the problem, contact your next level of
support for assistance.

6. Did the original failure occur while writing to a diskette?
v No: Go to step 8.
v Yes: Continue with the next step.

7. Try the original task again by using a new diskette.
v If the failure occurs again, go to step 10.
v If no failures occur, the original diskette was failing. This ends the procedure.

8. Re-create the information on the diskette, or obtain a new diskette with the information.
9. Try the original task again.
v If the failure occurs again, continue with the next step.
v If no failures occur, the original diskette was failing. This ends the procedure.

10. Perform Dynamic System Analysis to test the diskette drive. For more information about Dynamic
System Analysis, see Diagnostic tools.
v If the tests fail, isolate the problem using the procedures found in the server hardware

maintenance manual. For additional server maintenance information, see “Equivalent maintenance
information for the HMC server hardware” on page 9 to access the hardware maintenance manual
for your HMC server model.

v If the tests do not isolate the problem, contact your next level of support for assistance.
This ends the procedure.

Testing the HMC display:

Learn to test and diagnose HMC display problems.

To test for HMC display problems, complete the following steps:
1. Is the display type a 95xx (17P, 17X, 21P)?
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v No: Continue with the next step.
v Yes: 95xx-xxx repairs might require replacing internal display CRUs.

Repair and test the display using the procedures in Monitor Hardware Maintenance Manual Vol 2,
S41G-3317.

2. Is the display type a 65xx (P70, P200)?
v No: Continue with the next step.
v Yes: 65xx-xxx repairs might require replacing the entire display. There are no internal display CRUs.

Repair and test the display using the procedures in Monitor Hardware Maintenance Manual Vol 3, P
and G series, S52H-3679.
When the test and repair are complete, continue with step 5.

3. Is the display type a 65xx (P72, P202)?
v No: Continue with the next step.
v Yes: 65xx-xxx repairs might require replacing the entire display. There are no internal display CRUs.

Repair and test the display using the procedures in Color Monitor Operating Instructions.
When the test and repair are complete, continue with step 5.

4. Repair and test the display using the documentation included with the display. When the test and
repair are complete, continue with step 6.

5. Verify the repair. Perform Dynamic System Analysis to test the display. For more information about
Dynamic System Analysis, see Diagnostic tools.
When the test and repair are complete, continue to step 6.

6. Return the system to normal operations. This ends the procedure.

Replacing an HMC
Identifies the prerequisites needed and the tasks that must be performed when you replace a Hardware
Management Console (HMC).

If you are replacing an HMC that is set up as a DHCP server, you must first reinstall the HMC code base
by using one of the following:
v The recovery media that was provided with your HMC
v The recovery media that you last used to upgrade your HMC

You must also reinstall your customized HMC configuration data by using backup media.

Procedures for replacing an HMC differ, depending on which HMC version you have installed. To
determine your HMC version, see “Determining your HMC machine code version and release” on page
70 and then return here.

These instructions assume that you have created a backup of your HMC configuration data from the
HMC being replaced. For more information about backing up important HMC data, see “Backing up
critical HMC data” on page 69.

For HMC V4.5 or earlier

1. Insert the HMC recovery media, then power on or reboot the HMC. The HMC powers on and
loads from the media.

2. Press F8 to select Install/Recovery.
3. Press F1 to continue. After the installation is complete, the HMC prompts you to insert the

backup media.
4. Insert the backup media. When you are finished, the HMC is restored to the state that it was

in at the time that the backup was created.
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5. After the HMC interface has been restored, verify that your HMC DHCP private network is
configured correctly. For more information, see “Verifying that your HMC DHCP private
network is configured correctly.”

For HMC V5.0 or later

1. Insert the HMC recovery media, then power on or reboot the HMC. The HMC powers on
from the media and displays the Backup/Upgrade/Restore/Install panel.

2. Select Install and click Next. Wait for the installation to complete.
3. Select 1 - Install additional software from media from the menu displayed to install the

second HMC recovery media.
4. Remove the recovery media and insert the second media.
5. Press Enter to start the installation of the second recovery media.
6. After the installation is complete, remove the second recovery media, insert the backup media,

and select 1 - Restore Critical Console Data from the menu to restore data from the backup
media. When you are finished, the HMC is restored to the state that it was in at the time that
the backup was created.

7. After the HMC interface has been restored, verify that your HMC DHCP private network is
configured correctly. For more information, see “Verifying that your HMC DHCP private
network is configured correctly.”

Verifying that your HMC DHCP private network is configured correctly
Learn how to verify that all of your HMC DHCP private networks are configured correctly.

If your HMC is configured as a DHCP server on a private network and is not communicating correctly
with the managed system, or you have recently modified your network configuration (moved a managed
system, replaced an HMC, or added a second HMC), use the following instructions to determine if your
DHCP-managed private network is configured correctly.

Note: If your HMC is set up as a DHCP server on a private network, do not use the static IP commands
mksysconn and rmsysconn to change HMC connection settings. These commands are intended for use on a
public network only, where the HMC is not set up as DHCP server and managed servers use static IP
addresses.

If a system administrator previously assigned an IP address to the system through a manually executed
static IP command, Support must remove the manual connection and establish a DHCP connection
between the HMC and the server. This section describes how to identify any manually assigned IP
addresses so that an authorized service provider can remove them.

To identify a manually assigned IP address so that your HMC can communicate correctly with your
managed systems, you must perform the following high-level tasks. The following are detailed
step-by-step task descriptions.
v Identify the configured HMC IP connection addresses and compare them to the list of IP addresses

assigned by the DHCP server.
v Identify the HMC IP connection addresses that have been correctly assigned through the DHCP server,

for which no further action is required.
v Identify any manually configured HMC IP connection addresses that DHCP did not assign and that

need to be corrected by support.

To identify manually assigned IP addresses when the HMC is configured as a DHCP server, do the
following
1. Create a list of all of the configured HMC IP connections. On the HMC command line, type the

following command:
lssysconn -r all
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This command displays the following information for service processors and Bulk Power Cards
(BPCs) on the network for which the HMC has configured IP connection:
element type, MTMS, IP address(es), connection state

2. Make a note of all IP addresses that are displayed. You will need these addresses later.
3. Display a list of the DHCP IP addresses that have been assigned. To do this, type the following HMC

command:
lshmc -n -F clients

The output of this command lists all IP addresses that have been assigned by the HMC’s DHCP
server.

4. Make a note of all IP addresses that are listed in the output.
5. Compare the lssysconn and lshmc lists. If an IP address is displayed in the output for both the lshmc

-n -F clients and lssysconn -r all commands, the IP address was assigned by the HMC DHCP
server and the connection is being managed by the HMC DHCP server.

6. Remove from the list any address that is displayed in the output of the lshmc -n -F clients
command but not displayed in the output of the lssysconn -r all command, and is not in the list of
servers that use static IP addresses.

Note: If an IP address is displayed in the lshmc -n output and not in the lssysconn -r all output,
that IP address was assigned by the HMC DHCP server. However, it is not a current connection on
the HMC. The DHCP server keeps a history of all IP address assignments in the event that the
connection is re-established. The DHCP server might also have assigned an IP address if an unknown
device on the private network requested a DHCP IP address from the HMC.

7. If the HMC is managing servers on both a private and a public network, any connections to the
service processor on the public network (not in the private network address range) must also be
identified and removed from this list. If there are no IP adresses remaining in the list that contains the
lssyconn -r all output, the HMC DHCP server has assigned all of the system IP addresses, and the
network configuration is working correctly.

8. If there are any IP addresses not removed from the list taken from the lssysconn -r all command,
this address was not assigned by the HMC’s DHCP server. These IP address assignments must be
corrected, so that they can be automatically reassigned by the HMC DHCP server. Contact an
authorized service provider and request that someone correct the manually assigned IP addresses that
you have identified.

If you have followed this procedure and not all of your connections appear to be active, call an
authorized service provider for additional support.

Backing up critical HMC data
You can back up important console information to a location separate from the Hardware Management
Console (HMC).

Using the HMC, you can back up all important data, such as the following data:
v User-preference files
v User information
v HMC platform-configuration files
v HMC log files
v HMC updates through Install Corrective Service

The backup function saves the HMC data stored on the HMC hard disk to one of the following locations:
v Locally mounted USB flash memory drive
v Remote system mounted to the HMC file system (such as Network File System (NFS))
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v Remote site through File Transfer Protocol (FTP)

Back up the HMC after you change the HMC or the information associated with logical partitions.

To back up the HMC, you must be a member of one of the following roles:
v Super administrator
v Operator
v Service representative

To back up the HMC critical data, choose one of the following navigation options. The option that you
select depends on the interface type of the HMC:
v If you are using an HMC Classic or HMC Enhanced interface, complete the following steps:

1. In the navigation area, click HMC Management.
2. In the Operations area of the content pane, click Back Up Management Console Data.
3. Select an archive option.
4. Follow the instructions on the window to back up the data.

v If you are using an HMC Enhanced+ interface, complete the following steps:

1. In the navigation area, click the HMC Management icon , and then click Console
Management.

2. In the Maintenance and Data area of the content pane, click Backup Management Console Data.
3. Select an archive option.
4. Follow the instructions on the window to back up the data.

Determining your HMC machine code version and release
The level of machine code on the Hardware Management Console (HMC) determines the available
features while upgrading to a new release, including concurrent server firmware maintenance and
enhancements.

If you are using the HMC Classic or HMC Enhanced interface, see Determining your HMC machine code
version and release. If you are using the HMC Enhanced+ interface, see Determining your HMC machine
code version and release.

Preparing for HMC configuration
To configure the Hardware management Console (HMC), you must understand the related concepts to
gather the required configuration settings that you need to know before you begin the configuration
steps.

To prepare for HMC configuration, do the following steps:
1. Determine if this is a new HMC supporting one or more new systems, or if this is a second new

HMC supporting existing systems. This will determine which installation path to follow.
2. Determine the physical location of the HMC in relation to the servers it will manage. If the HMC is

more than 25 feet from its managed system, you must provide Web browser access to the HMC from
the managed system's location so that service personnel can access the HMC.

3. Identify the servers that the HMC will manage.
4. Determine whether you will use a private or an open network to manage servers. The HMC

manages the servers through the Flexible Service Processor (FSP) over a network connection. A
private network is a non-routable network from the HMC to one or more FSPs. An open network is
any routable network linking the HMC to FSPs, logical partitions, administrative workstations or
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other network devices, such as routers and firewalls. A private network is recommended for HMC
management of all systems. Servers that have bulk power controllers require a private network with
an HMC acting as a Dynamic Host Control Protocol server (DHCP). Review the available
non-routable network subnet ranges that are available and determine which one you will use for
each DHCP server. Each FSP may be connected to two HMCs acting as DHCP servers as long as
they are using two different IP address ranges.

5. If you will use an open network to manage an FSP, you must set the FSP's address manually
through the Advanced System Management Interface (ASMI) menus. A private, non-routable
network is recommended.

6. Determine the open network settings that you will need to connect the HMC to workstations used
by system administrators, logical partitions on the managed systems, and other network devices.
Also, determine how the HMC will “call home.” Call home options can include an outbound-only
Secure Sockets Layer (SSL) Internet connection, a modem, or a Virtual Private Network (VPN)
connection.

7. Determine the HMC users that you will create and their passwords, as well as which roles they will
be given.

8. Document the following company contact information that will be needed when configuring call
home:
v Company name
v Administrator contact
v e-mail address
v Telephone numbers
v Fax numbers
v The street address of the HMC physical location

9. If you plan to use e-mail to notify operators or systems administrators when information is sent to
IBM Service through call-home, identify the Simple Mail Transfer Protocol (SMTP) server and the
e-mail addresses you will use.

10. If this is a new HMC connecting to a new managed system, create a password that will be used to
authenticate the HMC to the system's service processor. At the same time, create a password for the
Advanced System Management Interface (ASMI) admin and general users. All three passwords can
be set when connecting the first time from the HMC to a new server. If the new HMC is to be used
as a redundant HMC, obtain the HMC user password from the already attached and configured
HMC. Be prepared to enter the password when you first connect to the managed server's service
processor.

Shutting down, restarting, logging off, and disconnecting the HMC
Learn how to shut down, restart, log off, and disconnect the Hardware Management Console (HMC)
interface.

Shut down, restart, log off, and disconnect the HMC interface.

Attention: Only use the white button on the HMC to perform a manual shutdown if the server does not
respond to any tasks performed from the console, such as shutting down the HMC.

If an operating system is running in a logical partition and you decide to shut down, restart, or log off
the HMC interface, the operating system continues to run without interruption.

Shutting down or restarting the HMC
To shutdown the HMC, choose one of the following navigation options depending on the interface type
of the HMC:
v If you are using an HMC Classic or HMC Enhanced interface, complete the following steps:

1. In the navigation area, open HMC Management.
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2. In the Operations area of the contents area, select Shut Down or Restart. The Shutdown or Restart
window opens.

3. From the Shut Down or Restart window, you can:
– Click Shutdown to end all tasks running on the console and shut down the HMC.
– Click Restart HMC to end all tasks running on the console and restart the HMC.

4. Click OK to proceed or click Cancel to exit the task.
v If you are using an HMC Enhanced + Tech Preview (Pre-GA) interface, complete the following steps:

1. In the navigation area, click the HMC Management icon , and then select Console
Management.

2. In the Management area of the content pane, select Shut Down or Restart the Management
Console.

3. From the Shut Down or Restart window, you can:
– Click Shutdown to end all tasks running on the console and shut down the HMC.
– Click Restart HMC to end all tasks running on the console and restart the HMC.

4. Click OK to proceed or click Cancel to exit the task.

Logging off the HMC
To log off the HMC, choose one of the following navigation options depending on the interface type of
the HMC:
v If you are using an HMC Classic or HMC Enhanced interface, complete the following steps:

1. In the main menu, click Logoff. The Choose to Logoff or Disconnect window opens.
2. Click Log off, and then click OK.

v If you are using an HMC Enhanced + Tech Preview (Pre-GA) interface, complete the following steps:
1. In the main menu, select the user name, and then click Logoff.
2. Click OK.

Disconnecting from the HMC interface
To disconnect from the HMC by using the HMC Classic or HMC Enhanced interface, complete the
following steps:

Note: The disconnect from the HMC option is available only in the HMC Classic or HMC Enhanced
interface.
1. In the main menu, click Logoff. The Choose to Logoff or Disconnect window opens.
2. Click Disconnect, and then click OK.
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Notices

This information was developed for products and services offered in the US.

IBM may not offer the products, services, or features discussed in this document in other countries.
Consult your local IBM representative for information on the products and services currently available in
your area. Any reference to an IBM product, program, or service is not intended to state or imply that
only that IBM product, program, or service may be used. Any functionally equivalent product, program,
or service that does not infringe any IBM intellectual property right may be used instead. However, it is
the user's responsibility to evaluate and verify the operation of any non-IBM product, program, or
service.

IBM may have patents or pending patent applications covering subject matter described in this
document. The furnishing of this document does not grant you any license to these patents. You can send
license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive, MD-NC119
Armonk, NY 10504-1785
US

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION "AS IS"
WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT
LIMITED TO, THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR
FITNESS FOR A PARTICULAR PURPOSE. Some jurisdictions do not allow disclaimer of express or
implied warranties in certain transactions, therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically
made to the information herein; these changes will be incorporated in new editions of the publication.
IBM may make improvements and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM websites are provided for convenience only and do not in
any manner serve as an endorsement of those websites. The materials at those websites are not part of
the materials for this IBM product and use of those websites is at your own risk.

IBM may use or distribute any of the information you provide in any way it believes appropriate without
incurring any obligation to you.

The performance data and client examples cited are presented for illustrative purposes only. Actual
performance results may vary depending on specific configurations and operating conditions.

Information concerning non-IBM products was obtained from the suppliers of those products, their
published announcements or other publicly available sources. IBM has not tested those products and
cannot confirm the accuracy of performance, compatibility or any other claims related to non-IBM
products. Questions on the capabilities of non-IBM products should be addressed to the suppliers of
those products.

Statements regarding IBM's future direction or intent are subject to change or withdrawal without notice,
and represent goals and objectives only.
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All IBM prices shown are IBM's suggested retail prices, are current and are subject to change without
notice. Dealer prices may vary.

This information is for planning purposes only. The information herein is subject to change before the
products described become available.

This information contains examples of data and reports used in daily business operations. To illustrate
them as completely as possible, the examples include the names of individuals, companies, brands, and
products. All of these names are fictitious and any similarity to actual people or business enterprises is
entirely coincidental.

If you are viewing this information in softcopy, the photographs and color illustrations may not appear.

The drawings and specifications contained herein shall not be reproduced in whole or in part without the
written permission of IBM.

IBM has prepared this information for use with the specific machines indicated. IBM makes no
representations that it is suitable for any other purpose.

IBM's computer systems contain mechanisms designed to reduce the possibility of undetected data
corruption or loss. This risk, however, cannot be eliminated. Users who experience unplanned outages,
system failures, power fluctuations or outages, or component failures must verify the accuracy of
operations performed and data saved or transmitted by the system at or near the time of the outage or
failure. In addition, users must establish procedures to ensure that there is independent data verification
before relying on such data in sensitive or critical operations. Users should periodically check IBM's
support websites for updated information and fixes applicable to the system and related software.

Homologation statement

This product may not be certified in your country for connection by any means whatsoever to interfaces
of public telecommunications networks. Further certification may be required by law prior to making any
such connection. Contact an IBM representative or reseller for any questions.

Accessibility features for IBM Power Systems servers
Accessibility features assist users who have a disability, such as restricted mobility or limited vision, to
use information technology content successfully.

Overview

The IBM Power Systems servers include the following major accessibility features:
v Keyboard-only operation
v Operations that use a screen reader

The IBM Power Systems servers use the latest W3C Standard, WAI-ARIA 1.0 (www.w3.org/TR/wai-aria/
), to ensure compliance with US Section 508 (www.access-board.gov/guidelines-and-standards/
communications-and-it/about-the-section-508-standards/section-508-standards) and Web Content
Accessibility Guidelines (WCAG) 2.0 (www.w3.org/TR/WCAG20/). To take advantage of accessibility
features, use the latest release of your screen reader and the latest web browser that is supported by the
IBM Power Systems servers.

The IBM Power Systems servers online product documentation in IBM Knowledge Center is enabled for
accessibility. The accessibility features of IBM Knowledge Center are described in the Accessibility section
of the IBM Knowledge Center help (www.ibm.com/support/knowledgecenter/doc/
kc_help.html#accessibility).
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Keyboard navigation

This product uses standard navigation keys.

Interface information

The IBM Power Systems servers user interfaces do not have content that flashes 2 - 55 times per second.

The IBM Power Systems servers web user interface relies on cascading style sheets to render content
properly and to provide a usable experience. The application provides an equivalent way for low-vision
users to use system display settings, including high-contrast mode. You can control font size by using the
device or web browser settings.

The IBM Power Systems servers web user interface includes WAI-ARIA navigational landmarks that you
can use to quickly navigate to functional areas in the application.

Vendor software

The IBM Power Systems servers include certain vendor software that is not covered under the IBM
license agreement. IBM makes no representation about the accessibility features of these products. Contact
the vendor for accessibility information about its products.

Related accessibility information

In addition to standard IBM help desk and support websites, IBM has a TTY telephone service for use by
deaf or hard of hearing customers to access sales and support services:

TTY service
800-IBM-3383 (800-426-3383)
(within North America)

For more information about the commitment that IBM has to accessibility, see IBM Accessibility
(www.ibm.com/able).

Privacy policy considerations
IBM Software products, including software as a service solutions, (“Software Offerings”) may use cookies
or other technologies to collect product usage information, to help improve the end user experience, to
tailor interactions with the end user, or for other purposes. In many cases no personally identifiable
information is collected by the Software Offerings. Some of our Software Offerings can help enable you to
collect personally identifiable information. If this Software Offering uses cookies to collect personally
identifiable information, specific information about this offering’s use of cookies is set forth below.

This Software Offering does not use cookies or other technologies to collect personally identifiable
information.

If the configurations deployed for this Software Offering provide you as the customer the ability to collect
personally identifiable information from end users via cookies and other technologies, you should seek
your own legal advice about any laws applicable to such data collection, including any requirements for
notice and consent.

For more information about the use of various technologies, including cookies, for these purposes, see
IBM’s Privacy Policy at http://www.ibm.com/privacy and IBM’s Online Privacy Statement at
http://www.ibm.com/privacy/details the section entitled “Cookies, Web Beacons and Other
Technologies” and the “IBM Software Products and Software-as-a-Service Privacy Statement” at
http://www.ibm.com/software/info/product-privacy.
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Trademarks
IBM, the IBM logo, and ibm.com are trademarks or registered trademarks of International Business
Machines Corp., registered in many jurisdictions worldwide. Other product and service names might be
trademarks of IBM or other companies. A current list of IBM trademarks is available on the web at
Copyright and trademark information at www.ibm.com/legal/copytrade.shtml.

Intel, Intel logo, Intel Inside, Intel Inside logo, Intel Centrino, Intel Centrino logo, Celeron, Intel Xeon,
Intel SpeedStep, Itanium, and Pentium are trademarks or registered trademarks of Intel Corporation or its
subsidiaries in the United States and other countries.

Electronic emission notices
When attaching a monitor to the equipment, you must use the designated monitor cable and any
interference suppression devices supplied with the monitor.

Class A Notices
The following Class A statements apply to the IBM servers that contain the POWER8 processor and its
features unless designated as electromagnetic compatibility (EMC) Class B in the feature information.

Federal Communications Commission (FCC) Statement

Note: This equipment has been tested and found to comply with the limits for a Class A digital device,
pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against
harmful interference when the equipment is operated in a commercial environment. This equipment
generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with
the instruction manual, may cause harmful interference to radio communications. Operation of this
equipment in a residential area is likely to cause harmful interference, in which case the user will be
required to correct the interference at his own expense.

Properly shielded and grounded cables and connectors must be used in order to meet FCC emission
limits. IBM is not responsible for any radio or television interference caused by using other than
recommended cables and connectors or by unauthorized changes or modifications to this equipment.
Unauthorized changes or modifications could void the user's authority to operate the equipment.

This device complies with Part 15 of the FCC rules. Operation is subject to the following two conditions:
(1) this device may not cause harmful interference, and (2) this device must accept any interference
received, including interference that may cause undesired operation.

Industry Canada Compliance Statement

CAN ICES-3 (A)/NMB-3(A)

European Community Compliance Statement

This product is in conformity with the protection requirements of EU Council Directive 2014/30/EU on
the approximation of the laws of the Member States relating to electromagnetic compatibility. IBM cannot
accept responsibility for any failure to satisfy the protection requirements resulting from a
non-recommended modification of the product, including the fitting of non-IBM option cards.

European Community contact:
IBM Deutschland GmbH
Technical Regulations, Abteilung M456
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IBM-Allee 1, 71139 Ehningen, Germany
Tel: +49 800 225 5426
email: halloibm@de.ibm.com

Warning: This is a Class A product. In a domestic environment, this product may cause radio
interference, in which case the user may be required to take adequate measures.

VCCI Statement - Japan

The following is a summary of the VCCI Japanese statement in the box above:

This is a Class A product based on the standard of the VCCI Council. If this equipment is used in a
domestic environment, radio interference may occur, in which case, the user may be required to take
corrective actions.

Japan Electronics and Information Technology Industries Association Statement

This statement explains the Japan JIS C 61000-3-2 product wattage compliance.

This statement explains the Japan Electronics and Information Technology Industries Association (JEITA)
statement for products less than or equal to 20 A per phase.

This statement explains the JEITA statement for products greater than 20 A, single phase.
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This statement explains the JEITA statement for products greater than 20 A per phase, three-phase.

Electromagnetic Interference (EMI) Statement - People's Republic of China

Declaration: This is a Class A product. In a domestic environment this product may cause radio
interference in which case the user may need to perform practical action.

Electromagnetic Interference (EMI) Statement - Taiwan

The following is a summary of the EMI Taiwan statement above.
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Warning: This is a Class A product. In a domestic environment this product may cause radio interference
in which case the user will be required to take adequate measures.

IBM Taiwan Contact Information:

Electromagnetic Interference (EMI) Statement - Korea

Germany Compliance Statement

Deutschsprachiger EU Hinweis: Hinweis für Geräte der Klasse A EU-Richtlinie zur
Elektromagnetischen Verträglichkeit

Dieses Produkt entspricht den Schutzanforderungen der EU-Richtlinie 2014/30/EU zur Angleichung der
Rechtsvorschriften über die elektromagnetische Verträglichkeit in den EU-Mitgliedsstaatenund hält die
Grenzwerte der EN 55022 / EN 55032 Klasse A ein.

Um dieses sicherzustellen, sind die Geräte wie in den Handbüchern beschrieben zu installieren und zu
betreiben. Des Weiteren dürfen auch nur von der IBM empfohlene Kabel angeschlossen werden. IBM
übernimmt keine Verantwortung für die Einhaltung der Schutzanforderungen, wenn das Produkt ohne
Zustimmung von IBM verändert bzw. wenn Erweiterungskomponenten von Fremdherstellern ohne
Empfehlung von IBM gesteckt/eingebaut werden.

EN 55022 / EN 55032 Klasse A Geräte müssen mit folgendem Warnhinweis versehen werden:
"Warnung: Dieses ist eine Einrichtung der Klasse A. Diese Einrichtung kann im Wohnbereich
Funk-Störungen verursachen; in diesem Fall kann vom Betreiber verlangt werden, angemessene
Maßnahmen zu ergreifen und dafür aufzukommen."

Deutschland: Einhaltung des Gesetzes über die elektromagnetische Verträglichkeit von Geräten

Dieses Produkt entspricht dem “Gesetz über die elektromagnetische Verträglichkeit von Geräten
(EMVG)“. Dies ist die Umsetzung der EU-Richtlinie 2014/30/EU in der Bundesrepublik Deutschland.

Zulassungsbescheinigung laut dem Deutschen Gesetz über die elektromagnetische Verträglichkeit von
Geräten (EMVG) (bzw. der EMC Richtlinie 2014/30/EU) für Geräte der Klasse A

Dieses Gerät ist berechtigt, in Übereinstimmung mit dem Deutschen EMVG das EG-Konformitätszeichen
- CE - zu führen.

Verantwortlich für die Einhaltung der EMV Vorschriften ist der Hersteller:
International Business Machines Corp.
New Orchard Road
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Armonk, New York 10504
Tel: 914-499-1900

Der verantwortliche Ansprechpartner des Herstellers in der EU ist:
IBM Deutschland GmbH
Technical Relations Europe, Abteilung M456
IBM-Allee 1, 71139 Ehningen, Germany
Tel: +49 (0) 800 225 5426
email: HalloIBM@de.ibm.com

Generelle Informationen:

Das Gerät erfüllt die Schutzanforderungen nach EN 55024 und EN 55022 / EN 55032 Klasse A.

Electromagnetic Interference (EMI) Statement - Russia

Class B Notices
The following Class B statements apply to features designated as electromagnetic compatibility (EMC)
Class B in the feature installation information.

Federal Communications Commission (FCC) Statement

This equipment has been tested and found to comply with the limits for a Class B digital device,
pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against
harmful interference in a residential installation.

This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in
accordance with the instructions, may cause harmful interference to radio communications. However,
there is no guarantee that interference will not occur in a particular installation.

If this equipment does cause harmful interference to radio or television reception, which can be
determined by turning the equipment off and on, the user is encouraged to try to correct the interference
by one or more of the following measures:
v Reorient or relocate the receiving antenna.
v Increase the separation between the equipment and receiver.
v Connect the equipment into an outlet on a circuit different from that to which the receiver is

connected.
v Consult an IBM-authorized dealer or service representative for help.

Properly shielded and grounded cables and connectors must be used in order to meet FCC emission
limits. Proper cables and connectors are available from IBM-authorized dealers. IBM is not responsible for
any radio or television interference caused by unauthorized changes or modifications to this equipment.
Unauthorized changes or modifications could void the user's authority to operate this equipment.

80 Hardware Management Console service (Machine Type 7042)



This device complies with Part 15 of the FCC rules. Operation is subject to the following two conditions:
(1) this device may not cause harmful interference, and (2) this device must accept any interference
received, including interference that may cause undesired operation.

Industry Canada Compliance Statement

CAN ICES-3 (B)/NMB-3(B)

European Community Compliance Statement

This product is in conformity with the protection requirements of EU Council Directive 2014/30/EU on
the approximation of the laws of the Member States relating to electromagnetic compatibility. IBM cannot
accept responsibility for any failure to satisfy the protection requirements resulting from a
non-recommended modification of the product, including the fitting of non-IBM option cards.

European Community contact:
IBM Deutschland GmbH
Technical Regulations, Abteilung M456
IBM-Allee 1, 71139 Ehningen, Germany
Tel: +49 800 225 5426
email: halloibm@de.ibm.com

VCCI Statement - Japan

Japan Electronics and Information Technology Industries Association Statement

This statement explains the Japan JIS C 61000-3-2 product wattage compliance.

This statement explains the Japan Electronics and Information Technology Industries Association (JEITA)
statement for products less than or equal to 20 A per phase.

This statement explains the JEITA statement for products greater than 20 A, single phase.
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This statement explains the JEITA statement for products greater than 20 A per phase, three-phase.

IBM Taiwan Contact Information

Germany Compliance Statement

Deutschsprachiger EU Hinweis: Hinweis für Geräte der Klasse B EU-Richtlinie zur
Elektromagnetischen Verträglichkeit

Dieses Produkt entspricht den Schutzanforderungen der EU-Richtlinie 2014/30/EU zur Angleichung der
Rechtsvorschriften über die elektromagnetische Verträglichkeit in den EU-Mitgliedsstaatenund hält die
Grenzwerte der EN 55022/ EN 55032 Klasse B ein.

Um dieses sicherzustellen, sind die Geräte wie in den Handbüchern beschrieben zu installieren und zu
betreiben. Des Weiteren dürfen auch nur von der IBM empfohlene Kabel angeschlossen werden. IBM
übernimmt keine Verantwortung für die Einhaltung der Schutzanforderungen, wenn das Produkt ohne
Zustimmung von IBM verändert bzw. wenn Erweiterungskomponenten von Fremdherstellern ohne
Empfehlung von IBM gesteckt/eingebaut werden.

Deutschland: Einhaltung des Gesetzes über die elektromagnetische Verträglichkeit von Geräten
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Dieses Produkt entspricht dem “Gesetz über die elektromagnetische Verträglichkeit von Geräten
(EMVG)“. Dies ist die Umsetzung der EU-Richtlinie 2014/30/EU in der Bundesrepublik Deutschland.

Zulassungsbescheinigung laut dem Deutschen Gesetz über die elektromagnetische Verträglichkeit von
Geräten (EMVG) (bzw. der EMC Richtlinie 2014/30/EU) für Geräte der Klasse B

Dieses Gerät ist berechtigt, in Übereinstimmung mit dem Deutschen EMVG das EG-Konformitätszeichen
- CE - zu führen.

Verantwortlich für die Einhaltung der EMV Vorschriften ist der Hersteller:
International Business Machines Corp.
New Orchard Road
Armonk, New York 10504
Tel: 914-499-1900

Der verantwortliche Ansprechpartner des Herstellers in der EU ist:
IBM Deutschland GmbH
Technical Relations Europe, Abteilung M456
IBM-Allee 1, 71139 Ehningen, Germany
Tel: +49 (0) 800 225 5426
email: HalloIBM@de.ibm.com

Generelle Informationen:

Das Gerät erfüllt die Schutzanforderungen nach EN 55024 und EN 55022/ EN 55032 Klasse B.

Terms and conditions
Permissions for the use of these publications are granted subject to the following terms and conditions.

Applicability: These terms and conditions are in addition to any terms of use for the IBM website.

Personal Use: You may reproduce these publications for your personal, noncommercial use provided that
all proprietary notices are preserved. You may not distribute, display or make derivative works of these
publications, or any portion thereof, without the express consent of IBM.

Commercial Use: You may reproduce, distribute and display these publications solely within your
enterprise provided that all proprietary notices are preserved. You may not make derivative works of
these publications, or reproduce, distribute or display these publications or any portion thereof outside
your enterprise, without the express consent of IBM.

Rights: Except as expressly granted in this permission, no other permissions, licenses or rights are
granted, either express or implied, to the publications or any information, data, software or other
intellectual property contained therein.

IBM reserves the right to withdraw the permissions granted herein whenever, in its discretion, the use of
the publications is detrimental to its interest or, as determined by IBM, the above instructions are not
being properly followed.

You may not download, export or re-export this information except in full compliance with all applicable
laws and regulations, including all United States export laws and regulations.

IBM MAKES NO GUARANTEE ABOUT THE CONTENT OF THESE PUBLICATIONS. THE
PUBLICATIONS ARE PROVIDED "AS-IS" AND WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESSED OR IMPLIED, INCLUDING BUT NOT LIMITED TO IMPLIED WARRANTIES OF
MERCHANTABILITY, NON-INFRINGEMENT, AND FITNESS FOR A PARTICULAR PURPOSE.
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